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OVERALL, LOGGING-IN & MANAGEMENT
OVERALL FUNCTIONALITY
Introduction
The Lexbe eDiscovery Platform (“LEP”) is a web-based litigation review and document management
application that assists lawyers, litigation support professionals, paralegals, and litigation teams in
managing legal document organization and review, litigation productions, legal document review, the
discovery process, and trial preparation. LEP is completely web-based and operates as a
‘cloud-computing’ Software-as-a-Service (SaaS) application, meaning LEP runs on any modern web
browser without any requirement for users to purchase special equipment or install any dedicated
software.
Hosted from limited access locked-down data centers with nightly backups and disaster recovery
procedures, LEP is highly secure. Files and data in LEP are encrypted in-place and in-transit, and web
access is through strong 256-bit SSL encryption. The data centers provide Service Organization Controls
1 & 2 reports published under SSAE 16 and ISAE 3402 professional standards (formerly SAS70 Type II
audits). HIPAA-covered entities may leverage our secure environment to process, maintain, and store
protected health information. Additionally, the data centers have achieved ISO 27001 certification and
been validated as Level 1 service providers under the PCI Data Security Standard (DSS).
eDiscovery Processing features include:
● File support of native email (e.g., Outlook, PSTs, EMLs and MSGs)
● File support of other native files (e.g., Word, Excel, PowerPoint)
● File support of image files (e.g., JPG, PNG, TIFF)
● File support of container files (e.g., ZIP, RAR)
● Supported files are automatically extracted and processed for viewing and searchability
● Metadata from native files is automatically extracted and fielded in the case database
● Early case analysis
● Dynamic culling by date, metadata fields, and full text keyword search
Document Review and Production features include:
● Full-text document sorting and filtering
● Document coding and tagging
● Unlimited custom fields
● Custodian tracking
● Email attachment linking and viewing
● Redaction editor
● Highlighting and annotation
● Hit-highlighting of search terms and static case keywords
● Ability to self-load to LEP, including from ConcordanceTM (DAT) and SummationTM (DII) compatible
systems
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●
●
●
●
●
●
●
●

Load files generated from LEP are usable in all major review platforms
Responsiveness, privilege, and confidentiality tagging
Mass tagging (multi-doc edit)
Automatic and custom privilege log generation
Bates numbering and productions (PDF, TIFF, native files, and load files)
Excel integration for reporting and updating metadata code
Review progress reporting
Offline access of documents through Briefcases

Deposition and Case Analysis features include:
● Fact and issue analysis
● Transcript highlighting and analysis
● Key document annotation
● Tracking of case participants/custodians
● Case research
● Fact and issue tracking
● Dynamic chronology and timeline generation
● Deposition analysis
● Annotate and highlight transcripts
These features can be used for early case analysis, deposition preparation, summary judgment and other
dispositive motion practice, and trial support.

Software & Internet Requirements
Browser Support
LEP is a web-based litigation document management and review application that operates on most
modern browsers. It supports the last two versions of Internet Explorer, Firefox, and Chrome for
Windows, and Safari and Firefox for the Mac. We recommend having two supported browsers installed
to assist with troubleshooting issues which may arise with a local browser.
Internet Connection Speed and Performance
LEP will run well on any modern internet connection. If upload and/or download speeds are too slow
(possibly due to shared use) then jobs will take longer. There are many good, free connection speed
tests available with which the time to upload and download files of a specified size may be estimated
(Google broadband speed test’ or ‘online speed test’).
It is important to test for both upload and download speeds. These are different and, for some
connections (e.g., home cable), the download speed may be many times faster than the upload speed.
Speeds may be quoted in Kbps or Mbps. 1 Mbps is equal to 1,024 Kbps.
ZIP or RAR files Before Transferring
Before transferring large file collections over the Internet, use an archiving utility to make an aggregate
compressed file or files (1 GB in size). Transferring many small files is significantly slower than an
archive. Popular archive formats are ZIP and RAR. ZIP archive utilities are built into all modern
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operating systems, however, Lexbe recommends and prefers RAR archives when sending files for
eDiscovery Services.

Online Help & Technical Notes
This manual presents an overview of LEP’s functionality and is intended to provide a general
understanding of the features available and practical aspects of the document review and production
process. It is NOT intended to provide a course of action for all possible scenarios. The content of this
manual is intended as a guide and must be considered in conjunction with the context-sensitive help
notes on every page of the application. These individual help pages are accessible by clicking the ‘Help’
hyperlink located at the upper-right corner of each page in LEP. The help page directly correlates with the
page being viewed in LEP. Search for any topic by using the search box that appears in the help page in
the upper right hand corner after clicking on “Help.”

Lexbe Support & Services
Customer needs are of critical importance to us here at Lexbe. Our dedicated team of eDiscovery
Specialists are poised and ready to assist our clients with support and technical issues that may occur
while using Lexbe software or services.
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We provide multiple service options depending on specific needs. Lexbe’s software and services include
free Customer Service access 24×7 via our ticket system and support resources. We also offer extended
support through Professional Services available on request (billable hourly). See the Lexbe Customer
Service Overview for a full description, which is available on our homepage.
If users are unable to access an account for any reason, such as a security lock-out, contact Lexbe
through the support ticket system or email. Users may also call Professional Services toll free anytime at
800-401-4710. There is no charge for assistance relating to account access.

FIRST TIME LOGIN, PASSWORDS & RECOVERY
Logging-In
To access LEP, open a browser window and navigate to LEP main page. To sign in, click the Login link
located in the upper-right corner of our website. From there, users will be taken to a login screen and
prompted to enter User Name (email address) and Password. The Password is sent to users by email
upon original user set-up by an Account Administrator or by Professional Services.

Recovering Passwords
To recover a password, click on the 'Recover Password' link within the login box. The new password will
be sent to the email address associated with the user.
If a password is entered incorrectly more than four times, users will be locked out of LEP (for security
purposes) and will need to contact support to reset the password.
If users cannot login to an account after following the steps mentioned above, please contact the Account
Administrator to confirm case/account access.
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Changing a Password
Users may change a password from the home/dashboard page under the tab (Management> Change
Password), after login to LEP. Passwords should be changed regularly to maintain the security of the
account.

CASE & USER MANAGEMENT
Creating New Cases
To create a new case, go the Account>Manage Cases page, select the account (if more than one) and
type the new case name in the text box on the left side of the page under 'Create New Case: Case
Name.' After adding a new case, users must also add user access, as applicable. This function is only
available to an Account Administrator.

Setting up Custom Case Fields
Create an unlimited number of custom fields and tags to identify and associate cases with multiple
specific issues established for individual cases (one case at a time) from the ‘Account> Manage Custom
Case Fields’ section.
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Add Case Section

Case sections are organized into expandable fields. Begin by setting up one or more sections to contain
and organize the fields. Examples of Case Sections that may be added to LEP to manage cases with a
large number of documents would be Case Management, Parties, Case Status, Case Venue, etc.
Add Case Field
Case fields are added in a similar fashion. First click on ‘Add Case Field’ and specify the label name and
whether a checkbox or text box is desired.

Only an account administrator may set up these fields, although all users can view and filter them.
Deleting Cases
Account Admin users can delete cases that are no longer needed. However, we recommend making a
backup copy of the entire database before deleting records from an account. Once deleted, users may
not be able to retrieve the case.
Once users remove the documents from LEP, and a backup copy is saved, please go to the
Account>Manage Cases page to perform the following steps:
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1. Select the Account (if applicable).
2. Select the case(s) to delete (check-box). This action will highlight the case(s) to be removed from the
account.
3. Expand the section called 'Delete Cases' and click on the 'Delete Selected Cases' button.

Case Recovery After Deletion
Whether or not a case can be recovered after deletion depends on Lexbe’s delete cycle from our data
backup storage. If the request is submitted within varying time periods, we may be able to recover a case
and metadata from backup. There is a recovery charge for this service if successful, and it generally
takes three (3) business days.
User associations to the case are not retained and, if recoverable, we assign the case to one Account
Administrator, who can grant further user rights as needed. If further assistance is required, users may
submit a support ticket or consult with Professional Services.
Archive Cases
Admin users may download and archive entire cases or a set of documents (zip format) to desktop as
follows:
From the Dashboard page select the account and case to archive.
If the need arises for a user to archive a case, a user may run a "Batesless" production. Please note that
if a user simply needs to export documents without load files, a briefcase export is preferable to this step.
For any questions about the reasons for a Batesless production versus a briefcase export, please contact
Professional Services.
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Creating Batesless Productions for Archival Purposes
Batesless productions are useful when the need arises to archive a case to retain for possible future
upload into an e-discovery platform.
Without loadfiles, the user cannot maintain email family
relationships. By running a Batesless production, all coding, custom fields, and email family relationships
are preserved for seamless upload in the future.
Running a Batesless production requires the typical production steps and validation procedures as
related to consistently coded email families. In order to preserve existing coding, it is imperative to export
all fields to Excel prior to running this production. After preserving the coding in the Excel log, mark all
produced documents as "Responsive." Any documents marked as Privileged will still be withheld.
Likewise, any documents coded as "Confidential" and/or having a Custom Designation will have those
PDFs stamped with the indicated Confidentiality designation. By preserving the coding ahead of time in
Excel, users may change the coding in the database to mark all documents as Responsive, Not
Privileged, and Not Confidential in order to get all documents out of the database cleanly.
To create a production without Bates stamps:
1. Follow all steps in the Production Job.
2. From the Production parameters box;
3. Un-check the Bates Stamp Pages checkbox, and put one "space" (i.e. one spacebar) in the Bates
Prefix field to tell LEP this is intentionally left blank.
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4. Check the box to include Native Emails.
5. To save and export metadata to an Excel Spreadsheet, navigate to Fields and select all Built In
fields that are not part of the DAT file, and all Custom Doc Fields
6. Click OK. Navigate back to the Browse screen. All metadata fields will now be displayed. Once
the user has confirmed all desired fields are displayed in the Browse view, select all documents
and choose Export to Excel.
7. Preserve all existing coding by exporting all fields to an Excel log. This step is critical to
preserving coding for responsiveness, privilege, and confidentiality. This log will also include all
custom fields and additional Lexbe fields that are not part of the standard DAT file that is
generated with a production.
8. After preserving the coding for responsiveness, privilege, and existing Bates numbers, the user
may run the Batesless production.
If using a Batesless production for the purpose of uploading to another e-discovery platform, it is
recommended that users reach out to Professional Services for assistance. Please reach out to the
assigned Sales Lead for a quote on that procedure.
In addition to the download production and procedures described above, we recommend the following:
●

Download any productions that have been run separately.
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●

Download Custodians and Facts & Issues, if present.

Account Billing Size
To review information related to the amount of data hosted by case, select an account under ‘Manage
Cases’, to view the section called 'Account Billing Size' as follows:

Immediately below the 'Select Account' drop-down list is information in green with monthly account billing
size as follows:
-One row per month.
-The current month as well as the previous four months.
The column "Current Case Size” reflects the amount of data hosted in the case. As long as no data has
been deleted, it will match the maximum billing information. If data has been deleted, please wait 24
hours for the amounts to update.

Creating New Users
Use this feature to manage users within cases from the ‘Account>Manage Users page. Account
Administrators have full control over an account’s settings and users. Account Administrators can also
remove administrators and other users from cases or the account, and only Account Admin users can
alter user permissions.
To create a new user in and account, select the account. Go to the section 'Create New user in Account'
and click ‘Add New User’ from the left menu. Users will be presented with a dialog box that will ask for the
new user email address. After granting account access, the new user must be assigned to at least one
case or the user will not be able to access any documents. Be sure to refresh the page if users are
unable to see either the new user’s name, or the cases available to assign.
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Types of Users & Setting-Up User Rights
There are several user types with differing rights and privileges in LEP account.
Available User Types and User Type Definitions
ACCOUNT ADMIN USER. The Account Admin User has full control over an account and access to all
features in LEP.
POWER USER. The Power User can do everything an Account Admin can do except for user
administration, creating and deleting cases, and Creating and Managing Review Sets.
STANDARD USER PLUS ADD and DELETE DOC. The Standard plus Add Delete Doc user has all the
rights of the Standard User AND can also upload or permanently delete documents.
STANDARD USER. This is the standard user for a document reviewer/coder. The Standard User can
access cases and perform a number of tasks available in LEP, but cannot, upload case documents, edit
custom fields, or permanently delete documents. Below is a list of Tabs and functions available for this
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user.
REVIEW USER. A Review User type can only see the Browse and Document Viewer pages and has a
limited view of review coding fields. A Review User cannot use the Search function or bulk download
documents using the briefcase function.
READ-ONLY USER: A Read-Only user can view the same pages as a Standard User, but cannot make
changes to anything. Nothing in the case will change as a result of Read-Only User actions.
LIMITED USER. A Limited User can only see certain documents from the Browse page that were
assigned by a Custom Coded Shared Checkbox Field. They will only be able to see the documents
chosen for review by the Account Admin and will not be able to code or search within those documents.
Please note: These permission levels/user types are all are fixed, but if the Admin Account user would
like to explore additional features being added to a permission level, or to a specific user, this can be
discussed by reaching out to your eDiscovery Solutions Director.

Deleting Users
Admin Account users can permanently remove other users from an account to disable access to any
cases or documents within LEP. To remove a user's access from a case or cases, first make sure 'Show
Columns>Show users' is checked. Select the user or users by checking the 'User Name' on the main
table and, finally, click on 'Remove users From Account.'
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UPLOADING, PROCESSING & OCR
UPLOADING DOCUMENTS & ESI
Uploading Batches of Files (no load files)
In order to fully optimize LEP system’s performance, ZIP or RAR compression is strongly recommended.
Individual or multiple files are compressed into a ‘batch file’, which is both smaller (faster
upload/download) and less prone to corruption. These batch files must be limited to 10 GB each. In the
case of multiple custodians or time zones, we recommend creating multiple batch files by each separate
criteria.
Windows Users: We recommend that WinRAR be installed and used for creating the compressed files as
part of LEP upload, production upload, and loadfile processing. Free versions and registered versions (for
a small cost) are available for Windows and in application GUI utilities and as command line utilities.
Other file compression programs may work, but we have not tested them and do not support them. We
recommend and support WinRAR for uploading and producing documents because it is consistent and
includes robust error checking. It may also be possible to create compressed files that can be
successfully uploaded and expanded using Windows built-in ZIP compression and other utilities, but we
strongly recommend using WinRAR to avoid file extraction errors.
MAC Users: Mac has built-in support utility for zipping and unzipping files, that users can also use for
creating the ZIP files as part of the upload, production upload and loadfile process. Please note that the
MAC built-in compression extraction application sometimes might not open ZIP files properly, so we
recommend that users install KeKa utility for Mac to compress/extract files or users may also want to try
using free ZIP compressor/extractors utilities available for Mac that are currently more efficient than the
built-in extractor.

Multipart Upload
LEP high-speed multipart upload feature breaks large files into multiple parts and uploads them in
parallel.

Adding Documents to a Case
Users with Upload rights can upload individual or batches of documents (also known as electronically
stored information, or ‘ESI’) to a case by selecting (Case>Upload Case Documents) from the top menu,
and clicking on the ‘Upload’ button on the left side of the “Upload” window.
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We recommend that case files be uploaded in batches one custodian at a time. This allows users to
assign the custodian at the time of upload and have it automatically assign to all documents in the batch.
Custodians must be set up before starting the upload. Users can upload individual files to case(s) in LEP
without applying ZIP or RAR compression (e.g. PSTs, EMLs, MSGs, RAR, ZIP). However, when users
are working with larger document sets, those files should be compressed prior to upload.
After clicking on the ‘Upload’ button a new dialog box will appear. Please complete the items listed below
and then click 'Upload’ to begin uploading files.
Before uploading, users can set the following fields:

●

●

● Batch Title: Unique name
for each batch file uploaded to the
case.
● Batch Comments: Provides
a text area for a description or
additional information related to the
upload batch. This could include
where the batch contents were
collected, collection procedures, etc.
● Doc Source: Used to identify
sources of documents to allow
filtering by source for searches and other functions. When set before uploading the batch, the
added files will all be automatically assigned to the directed ‘DocSource.’ DocSource, like other
fields in LEP, can also be changed later using the Multi-Doc Edit function.
Case Custodian: By default, new upload batches have a 'Custodian' set as 'Unassigned.' Please
note that ‘Custodian’ needs to be set up prior to initiating an upload. A drop down list allows users
to associate a Custodian with a particular upload batch. This can be a document custodian, party,
or an unspecified shared collection (e.g., ‘Shared Drive at Office').
Time Zone Offset: The default is Universal Time (aka 'Greenwich Mean Time'). The time zone
can be adjusted for each upload batch as needed. If the files uploaded were part of an eDiscovery
Services job, we process, convert, and load using EST, or Greenwich Mean Time (Universal Time)
-5 hours. The time that displays on an MSG in Outlook is dependent on the local settings on the
client computer where Outlook is installed and will vary based on these local settings, daylight
savings time, etc. As a result, time zone differences of an hour or more are common and
expected, especially if a custodian was traveling to different time zones during the case. If the
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●

exact time of emails in a case is important, email can be processed to GMT/Universal time, and a
log of custodian settings and travel can be obtained.
Perform OCR on PDFs: PDFs are automatically made searchable with optical character
recognition (OCR) and checked by default (English only). If it is important that PDF documents be
immediately searchable, users should apply OCR before uploading to LEP. After the upload is
completed, we advise users to check from the Search page to make sure all the documents
recently uploaded were OCRed. If OCR processing is still in progress, users will see a note that
says: 'Search results may be incomplete because items are still being indexed or OCRed. XX
documents remain.' Also, the amount of time this can take will vary depending on the number and
size of documents uploaded and activities of other users in the account as OCR is a shared
service. Users can leave this option unchecked if documents have been previously OCRed or if
users want to retain foreign language text in uploaded files.

Upload Progress & Notification of Upload Complete
After uploading files to a case, users may click on the 'Processing' hyperlink at the top right of the screen,
to receive automatic email notifications when a processing/upload is completed successfully, while
continuing to do other work.

Uploading Nested Folder-Structure
When users finish uploading data, if there is a nested folder structure in in an uploaded container file
(e.g., ZIP, PST), then the paths will be automatically mapped to a built-in field (column) called ‘Source
FilePath’ in the application. This field is displayed in the Browse and Search pages, and it allows users to
view, sort, and filter on the original folder name or retrieve files that were within it. Users can also use
Saved & Shared Filters to organize and work with sub-folder structures.
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Upload TIFFs or Natives (with Load Files)
This feature is a practical tool when needing to upload multiple files under one record in LEP (self-loading
Summation and Concordance load files). Users can upload a production to LEP from the ‘Case>Add
Case Documents’ page using a compressed file format with the file name ending with the extension
'.lexbeupload.zip' (e.g., EnronProd001.lexbeupload.zip). LEP is compatible with .dii, .dat, and .opt load
files. We also are able to prepare load files in these formats to load document collections into
Concordance or Summation review systems. LEP load files are prepared in Excel 2010-2013 format. We
recommend this feature for Power Upload users who are also advanced Excel users familiar with using
complex formulas and data management features for Quality Assurance & Control. For more information,
please visit the help pages on uploading metadata and upload productions, or contact a Professional
Services representative.

Add Case Documents Report
Report Hyperlinks: After uploading batches of files, this feature will allow users to go from the Upload to
Case Assessment pages, and generate reports based on different options such as 'Doc Count By Master
Date', 'Doc Count By Extension', 'Doc Count Unsupported by Extension', and 'Doc Count Failed To
Convert by Extension'. For example, if users click on the option 'Doc Count By Master Date', the hyperlink
will take users to the Case Assessment page and display a report showing the file count based on the
'Master Date', which is the field that captures the main date and time an email family was sent (email and
its attachments) or for non-emails the last date modified or the date created (if date last modified is not
available).

Internet Connection Speeds
LEP has extremely fast connection speeds coming out of our data centers (1 Gbps connections) and we
monitor connection speeds to determine that our network is not causing slow performance speeds.
Users should first test internet speed to determine upload and download speeds, and then estimate how
long it will take to transfer over the Internet. Upload and download speeds are different and for some
connections (e.g., home cable) the download speed may be many times faster than the upload speed.
Speeds may be quoted in Kbps or Mbps. 1 Mbps equals approximately 1,000 Kbps (actually 1,024 Kbps).
We recommend that uploads and downloads be of a size that users can comfortably complete within two
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hours. Longer times are sometimes possible, but risk timeout, connection interruption, or failure from a
variety of sources that may require that users start over again.
Consider Shipping Large Data Collections by Flash Drive
If data transfer needs and speed are such that a transfer will take more than a couple of hours, consider
copying to a flash or portable drive and shipping by overnight courier. If users have asked us to deliver
eDiscovery ESI to others by Shared Download Link and think that may not work now due to connection
speed, Professional Services can access the files locally and send to users on a flash drive by overnight
courier (additional data transfer and hourly charges will apply).

Case Dashboard
Users can access this feature from the 'Analysis' Tab, to the left of top navigation bar. It will help users
visualize the document activity in a case based over a period of time, as the volume of data uploaded
might substantially increase.
Calendar Chart
The calendar charts in the Case Dashboard page provide a quick visual representation of how many
documents were uploaded by month based on the Master Date field and Year. For example, several
productions are received within the same month and a user wants to make sure there are no gaps in
those productions. The graphs generated from the Case Dashboard support timeline gap detection.
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EDISCOVERY PROCESSING & METADATA EXTRACTION
eDiscovery Processing
LEP automatically provides eDiscovery Processing for files uploaded. eDiscovery processing represents
a series of operations done on files (aka ESI) to ready them for document review or production. These
processes include:
● Container file decompression, extraction, and separation
● File type identification and extension repair
● Metadata extraction and database fielding to Built-in fields
● System file identification and deNISTing
● Native text extraction for dual search index
● Conversion of supported file types to normalized PDF for viewing
● Creation of PDF Placeholder files for unsupported or unconverted files
● Optical character recognition (OCR) of image files, and text extraction for dual index database
indexing

Supported File Types
LEP supports the conversion of over 100 native file types. These include Outlook Email (PST or MSG),
PDFs (image or text based), native application file types (e.g., Word, Excel, PowerPoint and other
Microsoft Office file types), web pages, image files (e.g., JPG, PNG, BMP, TIFF), and many more. Users
can also upload, store, and code audio and video file types such as WMV, WMA, MP3, AVI, MP4, & MOV,
but they cannot be converted to PDF. See Appendix B for more details.

PDF CREATION, PLACEHOLDERS, OCR & INDEX
PDF Creation & OCR
Supported file types are automatically converted to normalized and searchable PDF files for viewing,
Bates-stamping, and downloading. We also retain, link, and view the extracted native file, including
attachments to ensure users can always view both native and PDF versions of the file. In the unusual
case that a file does not convert, a native version of the file will still be available for review and a PDF
placeholder will be created. Viewing options (tabs in our Document Viewer) include original file uploaded
(e.g., Word, Excel, MSG email), a formatted HTML/text version, and the normalized PDF version. LEP
applies OCR to make image PDFs and other supported images’ text searchable.

Placeholder Files
Normalized PDF files created as part of ESI processing and conversion (or a resulting TIFF file in a
production) might include files that will generate a placeholder when users open an individual document
from the Document Viewer. This may indicate the following:
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Files 'Failed to Convert’: Indicates that a
standard or supported file type did not convert.
This can occur for a variety of reasons, including
file corruption, file type misidentification, print or
data extraction errors, and password protection.
Files 'Not Converted': Indicates that a non-standard or unsupported file type has not converted. This
might include certain unsupported media files, container files, email files, and database files.
Please note that ‘automated processing’ does not mean that every file will be expanded or converted as
may happen if each file is converted manually. Failed file conversions during automated processing can
be caused by many factors, including the variety of file types, extent of support of software libraries we
use, partial data corruption, and other issues.
Some standard file types that fail to convert can be converted manually by Professional Services (hourly
or per GB charges depending on file type and issues involved).

OCR
OCR or 'Optical Character Recognition' is the process of taking image files (e.g., scanned from
documents) and electronically converting them into searchable text. LEP will OCR all image based PDFs
(discarding prior OCR text and replacing), unless 'No OCR' is selected at the time of upload.
When OCRing supported image files (e.g., TIFF images), LEP creates a corresponding text file
containing OCR text. For example, if a TIFF image was named SMITH 00000100.TIF, the corresponding
text file containing the results of OCR would be named SMITH 00000100.TXT. Single page TIFFs are
not OCRed in LEP.

Extracted Metadata
LEP includes extracted metadata of uploaded emails (email sender, receiver, date, time, and subject), as
well as author and date last modified for native files, which can be used for document collection, culling,
and organization. In particular, use of extracted metadata can greatly speed and ease preparation of
Privilege Logs. The final Privilege Log is created in Excel and can be downloaded and further reviewed.

AUTOMATED PROCESSING & QUALITY CONTROL
Automatic Processing & Quality Control
LEP is an automated eDiscovery Processing application and the user should apply the desired level of
quality control.
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Automated file processing refers to changing the state of ESI without the application of direct human
error-checking or proofing. We utilize automated file processing to keep the costs of our LEP and
services reasonable. Many eDiscovery processes now involve hundreds of thousands of files, millions of
page equivalents and billions of individual processes. If human manual labor were required for all or
even a small portion of files, page-equivalents or processes, then the cost for many jobs would be very
high and cost-prohibitive.
For example, if a user uploaded 10,000 emails, that could result in a total of 20,000 documents because
of file expansion, extracting and converting the email families (body and attachments), and other
container files (e.g. ZIP) into individual, searchable, normalized PDF documents. In addition to the
expansion, during the upload our platform also creates a search index that LEP prepares to make the
documents in the case searchable and OCRed versions of files to include text prior to upload with
DeNIST and extension repair procedures.
The following are quality control steps suggested to apply following completion of an ESI upload:
● Check the number of uploaded files against what was processed. Emails and container files
separate and expand during processing and so the number of processed files should be greater
than the number of uploaded files. This can be checked by upload batch or Custodian.
● From Browse, filter on placeholder files to review files that have not converted. These files may
require manual conversion.
● From Browse, show the ‘Pages’ and ‘Words’ column(s). Filter based on file types in which text is
expected. View these files in which users would expect to see text (e.g., word processing,
spreadsheets, etc.) and if there are no or few words extracted or OCRed, these files’ text may not
have extracted properly or OCR may have failed.
● Scan and repair PSTs prior to upload.
● For PST files, compare the number of email messages uploaded with the MSGs extracted. This
can be done by filtering based on file extension (msg) from the Browse screen.

Duplicates & Deduplication
Deduplication in LEP helps users reduce the size of a document collection by giving users the ability to
identify duplicate file copies and remove them from a case. This can help optimize the review process by
reducing review inconsistencies, errors, and review costs. This feature is available from the ‘Case>Add
Case Documents page.’
For native files uploaded to LEP, or as part of an eDiscovery Service that supports deduplication, we
identify duplicates within a job (for eDiscovery Services) or within a case for LEP. If users wish for
duplicates to be deleted in an eDiscovery Services job, users need to request this specifically and it also
needs to be indicated on the job acceptance email. This flexibility is often needed as custodians in a case
can change. Deduplication is done within identified Custodians only (using the Custodian field in LEP),
and not between Custodians. If no Custodians are identified in an LEP case (i.e., Custodians assigned)
or Participant-Custodians are unassigned as part of an eDiscovery Services job, then deduplication is
applied across all documents.
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Duplicates in Loaded TIFF Productions
If an uploaded TIFF Production includes duplicates, these cannot be deduplicated. The TIFFs,
separately generated, will hash differently and therefore will not be exact duplicates. Two other methods
are possible to identify:
NearDup+ service. Documents grouped will not necessarily be exact duplicates, but will be grouped for
bulk review and coding. This service is provided by Professional Services. Contact a sales director for a
quote.
Incoming TIFF load files with MD-5 hash values. The user (or Professional Services) can group files in a
custom field to allow for bulk review and coding.

Please note, the prime document is always the first uploaded to LEP. This ensures that any version
added to LEP at a later time is marked as a duplicate and will not replace the prime version that may
already be coded. .
LEP will categorize duplicate files under the column IsDuplicate that can be accessed from the Browse
and Search pages (Sort, Show Columns or Select Filters).
Filter For Duplicates
Once deduplication is completed, go to the Browse or Search pages and apply one of the following filters:
Duplicate->Show Duplicates Only. Will only display the group of files marked as duplicates.
Duplicates->Exclude Duplicates. Will hide all files marked as IsDuplicate in the case. Filters will not
change the file count within a case (no automatic deletion). For purposes of LEP Storage Calculation
delete any unneeded files from the case.
When the filter is applied, LEP automatically saves the filter under the Filter Quick Links section and
creates filter hyperlinks to open a specific set of documents. Rename the filter by clicking the Edit
hyperlink.
The user can also access duplicate files from the Document Viewer, identified under the Exact Duplicate
section. From this page the user is able to find similar key documents, accelerate review by mass tagging
similar documents, and check consistency on responsiveness and privilege groupings between similar
documents, email threading, etc.
Deleting Duplicates
To remove duplicate files, apply filter on Show Duplicates Only, select All XX Documents in Case.
Deleted duplicates cannot be recovered.
An alternative is to filter for view (Select
Filter->Duplicates->Exclude Duplicates) or download before deleting, so recovery is possible. Best
practice is to create a download Briefcase as a backup and save to desktop. There is not a 100%
guaranteed way to detect duplicates. Best practice is to not delete duplicates marked as
IsEmailAttachment in LEP. An attachment generally should not be deleted as a duplicate unless the entire
email body is as well. Otherwise, the email family will be broken and the Document Viewer
will not associate them. LEP will not deduplicate email attachments from different email families.
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Near Deduplication
Near Duplication identifies files and emails that are nearly identical (50% similar in text content). This
would include, for example, multiple versions of a Microsoft Word document with slight modifications over
time or a repetitive chain of email threads. Examples of documents that appear to be exact duplicates,
but are different based on computer analysis could be documents scanned at different times, email
threads , documents saved to PDF at different times, or documents with small unobservable editing
changes. Near Duplication is a service provided by Professional Services. Contact an eDiscovery
Solutions Director for pricing information.

Benefits Of Near Duplication
Near duplication, which is independent of deduplication, benefits reviewers in many ways. Users can find
similar documents once a hot document has been identified. Users will reduce the chance of inadvertent
privilege document release by identifying documents that are similar to ones marked privilege or work
product. Near Duplication will reduce the number of documents hosted in a review environment, which
will also reduce review time by allowing large batches of similar documents to be reviewed and coded at
one time.
Near Duplication and Emails
LEP looks vertically through a custodian's emails for near duplicates and will take both the email and any
attachments (the entire family) and mark as a near duplicate. If a custodian's email is deleted the
attachment will also be deleted.
Separate versions of the same document may be attached to different email custodians. These are not
marked as exact duplicates, but retained for email family integrity. Therefore, the same document may
appear in different custodian's documents.
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The user may identify related email families by content in order to identify all emails in a group, detect
missing emails, and then keep only the relevant email messages for review.
How it Works
After Professional Services performs NearDup, the database will be updated with near-duplicate
groupings of documents. The user will also receive an Excel spreadsheet report entitled NearDup
Grouping Report.
This feature only marks near-duplicates. It does not delete them (no batch title selection necessary). All
existing files with similar contents will be grouped across the entire case (e.g. Group 1, Group 2, etc).
How to Identify Near Duplicates
LEP will categorize the near duplicate files under the same group with identical numerical values (e.g.,
Group 1) that can be accessed from Browse and Search pages (Sort, Show Fields or Select Filters).
The user may also access near duplicate files from the the Document Viewer (Near Duplicates section).
Filtering Near Duplicate Groups
1. Use filters to narrow a search for a specific set of documents or select to view only a particular
Near Dupe Group ID by indicating that specified ID in the textbox.
2. Show Fields for All Near Duplicate Group. From the Search or Browse pages, click on
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Fields->Select Fields->Near Dup Groups. This will display all the near duplicates classified in the
groups.
3. Filter and Display One Group. To narrow the results and show only one specific Near Dup Group,
filter by Near Dup Group No., for example 3472.
4. Sort on Specific Groups. Sort on the groups by clicking on the field title Near Dup Group.
5. Export Log to Excel. Export the near duplicate log to an Excel spreadsheet to keep track of
documents produced where privileged information might not have been removed. An Excel log
allows the user to filter, sort, and see if there are near duplicates inconsistently coded (e.g.,
confidentiality, email threading, attachment, etc.).

Manually Identify and Review Near Duplicates
From the Browse or Search pages, show only Near Dup Group.
Go to Field->Show Field
Section->Built-in Doc Fields.
Select the Original Title, Ext, Pages, Words, Size, and IsEmailAttachment columns.
Risks Of Deleting Email Attachments
As a best practice, do not delete near duplicates marked as IsEmailAttachment so that users reviewing
an email collection will be able to establish how the content was distributed and who may have been
sharing information. Often, email (MSGs) created by different custodians will contain the same
attachments.
An email attachment and a loose file that are near duplicates will not be in the same group. Generally,
email attachments should not be deleted as near duplicates, unless the entire email body is deleted also.
LEP will not near dedup email attachments from different email families.

Applying Control Numbers
Users can apply control numbers to the documents uploaded into a case. Control numbers are similar to
Bates numbers in that they are sequential and can be printed on documents from the ‘Case>Add Case
Documents page.’ After all uploads in the queue have been completed, expand the Control Numbers
drop-down and click "Assign to Case Docs" button. Unlike a bates number, which is page based, one
control number will be assigned to each document in the case. It will start from an initial number of digits
(e.g., '1') determined by the user conducting the upload.
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Control numbers will be applied quickly and help to simplify the cumbersome tasks of managing
document revisions, assembling document issues, and maintaining the project document review before
Bates stamping is applied to the actual production. Control numbers are 'document specific,' which
means that the same control number is applied to the whole document. When users open a PDF file, the
same control number will be displayed on each page.

Once control numbers are applied, users can download documents with control numbers printed on them
through a Download Briefcase created from the ‘Search’ and ‘Browse’ pages. After assigning control
numbers to a batch of files this feature will also automatically check through the entire library of a case to
ensure the numbers are not duplicated on any other documents. If users decide to apply control numbers
to subsequent batches of files this feature picks up where the last applied control number left off. There
will be only one control number created and viewable after the document has been added to the case.
We do not recommend applying Bates numbers prior to a production. Doing so will prevent users from
using all of our production features as the documents will be re-Bates stamped at that time in a different
order. Users could download documents through the Briefcase, but we don't recommend that for a
production, as it bypasses the safeguards for privilege and other quality control procedures specifically
designed for productions.
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CASE ASSESSMENT
LEP provides users with the ability to create advanced visual reports during the review process and to
more effectively manage eDiscovery progress and workflows. Case assessment tools simplify the
investigation of relevant documents by creating reports that will automatically extract, organize, and
summarize the specific data selected with respect to the documents uploaded to the current case. Users
can create customized reports that show only specified document or data criteria. The example below
shows users a case assessment report for the documents marked as 'Attorney-Client Privilege,' ‘Review
Status,’ ‘Doc Count,’ and ‘Current Year.’
The results of the current report can be exported to an Excel spreadsheet using Export to Excel. The
export is limited to 100 entries. For reports larger than 100 rows, contact Lexbe Professional Services.
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DOCUMENT CODING & REVIEW
BUILT-IN AND CUSTOM DOCUMENT FIELDS
LEP includes a number of built-in fields that represent standardized discovery review fields such as
‘Responsive,’ ‘Privileged,’ etc., that are used in many cases. Users also have the ability to set up an
unlimited number of custom fields and sections particular to a case. Fields can be associated with more
than one document, making them highly functional. Once coded, documents can be displayed with their
field associations in many parts of LEP, including Browse, Search and the Document Viewer. Documents
and their field associations can also be downloaded to Excel, edited and reuploaded to modify the case
database.

Custom Document Fields In LEP
There are two coding field sections that can be accessed from the ‘Browse,’ ‘Search,’ and ‘Document
Viewer’ pages. To access from the Browse or Search pages, navigate to 'fields’' on the left side of the
screen. Click on the arrows to expand the field. Then click on the 'show fields’' hyperlink. This will bring
up a new window with both built-in and custom doc fields.

1- Built-in Doc Fields: Built-in fields are automatically included in LEP and allow users to code and filter
on case data, better integrate metadata extracted during eDiscovery Processing, and upload coding
designations from load files when receiving productions or uploads from other review systems. For
example, the ‘Date’ field can be used as a controlling field and, during review, allows users to consolidate
the dates for searching, filtering, and eventually producing files. The ‘Date’ field is blank by default.
2- Custom Doc Fields: Custom fields are set up by Account Administrators to identify and associate
documents with case-specific issues users have established for the ESI being reviewed. If users wish,
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staff from Professional Services can assist in setting up custom doc fields prior to starting a document
review.

Custom Coding Section & Coding Fields
Custom Coding Section is the unique name of a custom column and it
only allows text in its titles; while custom coding fields will be the tags
under the coding section that can be either checkboxes or text boxes.

How to Set Up Custom Coding Section and Fields
Custom coding fields are organized into expandable
sections. Users should first set up one or more
coding sections to contain and organize the custom
fields. Examples of coding section names could be
‘Liability Issues,’ ‘Deponents,’ etc. NOTE: All fields
must be located in a section or the fields will not
display on the document viewer. Users add a section
by clicking on ‘Add Case Section’ and entering the section name. Coding fields are added in a similar
fashion. First click on ‘Add Coding Field’ and specify the label name and whether a checkbox or text box
is desired (e.g., ‘Fraud on Market,’ ‘Conspiracy’).

Applying Custom Doc Fields
From the Browse and Search pages, users
can select multiple documents and use the
‘Multi Doc Edit’ feature to code documents
simultaneously. When coding multiple
documents we recommend the following:
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From the ‘Document Viewer>Discovery’ tab (Linear Review) when users click on a document title from
the ‘Browse,’ ‘Search,’ or ‘Fact & Issues’ pages, a listing of up to 25 of the documents displayed in those
pages will be carried over to the Document Viewer. From the ‘Disc’ tab, apply the necessary tag to the
emails and their attachments. Users can then scroll back and forth between these documents in whatever
tag view being used in the navigation arrows at the top of the page (e.g., '<Viewing 2 of 25:>') or by using
the ‘Save & Next’ hyperlink to move to the next document.

Coding Using Excel & Upload Metadata
Users can modify document coding and tag multiple files simultaneously by generating custom Excel
spreadsheets and uploading them back into a case. This allows the user to edit most fields in LEP,
restore email families in an Excel spreadsheet, upload that spreadsheet to the applicable case, and have
the field data in LEP be automatically updated. This function is only available for specific users with
'Power Upload' privileges enabled, and an Account Admin User must contact customer support to
activate this functionality for themselves or other users.

BROWSING, SORTING, & FILTERING DOCUMENTS
After users have uploaded documents to a case and processing is complete, users can access them from
different pages in LEP.

Browse
The Browse page (accessible from the Browse tab) will show all documents in the current case in tabular
format by title, and any other fields users wish to display. From Browse, users can open documents in
the document viewer. Browse also allows users to edit/delete documents.

Lexbe eDiscovery Pla orm User Manual 2-2018

Page 29

Browser & Search Fields Display
Users can display or hide fields in the main table. To customize the field display, go to the ‘Fields’ section
and select ‘Show Fields.’

‘Show Fields’ will allow users to display any of LEPs built-in fields (see Appendix C), including ‘Document
Title,’ ‘Bates Number,’ ‘Custodian,’ ‘File Extension,’ ‘Responsive,’ ‘Privilege,’ etc., and custom fields.

Filtering on Documents
Users can apply filters from the ‘Browse’ and ‘Search’ pages. This feature enables users to take the
existing coding sections (e.g., ‘Title,’ ‘Bates,’ ‘Doc Source,’ ‘Date Uploaded,’ etc.), and narrow down the
results based on criteria that match/don't match. To do this, select ‘Filters>Select Custom Filters’ from
the left margin. Then users can select which filters to apply from the drop down menus. Click ‘Apply’ and
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the document set will be filtered. When filtering on text fields users can add any part of the text and the
filter will include a partial match.
If users select from multiple filters,
the results will be calculated as
follows: Fields within a section will
be disjunctive (joined with an ‘OR’)
and results for each selected
section will be joined conjunctively
(joined with an ‘AND’) with the
results from other sections. In the
example here, the filtered results
would include the text entered
under the Off-Balancing Sheet
Pships fields (Chewco OR Jedi’),
and NOT Fraud on Market_2 in
which related ‘Confidential’ data was checked.

Saved and Shared Filters
Filters are automatically saved in the database whenever users click ‘Apply’ in the ‘Filter>Select Filters’
dialog box from the Browse or Search pages. This action automatically preserves the filter records on the
list view under the ‘Recent’ section and creates filter hyperlinks to open a specific set of documents.
Please note that the default link titles are under the 'Recent Filter YYYY-DD-MM' format, but users can
rename them by clicking on the ‘Edit’ hyperlink. It will also allow users to pin and share the most used
filters and delete existing records.
The Filter Quick Links section is divided into three subsections:
Shared. View the filters shared with all users in a case. To share or
unshare filters with other users in the current case click 'Edit' and
check or uncheck the 'Shared' icon check-box when the
Shared/Pinned Filters dialog box appears. Please note that this
option will share filters with all current users that have access to the
case.
Pinned. To create ‘Pinned’ filters click ‘Edit,’ select a recent filter by
the title, and then use the check-box under the pin symbol. Finally,
click 'OK' to save these changes or 'Cancel' to not save any
changes made. The pin icon will move a selected recent filter to the
‘Pinned’ section. Pinned filters are saved for the user that creates
the link, but are not accessible to other users.
Recent. The applied filter history is shown under ‘Recent.’ The screen displays the five most recent filters;
but if users click ‘Edit’ a full list of filters which have been applied in the past are displayed.
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SEARCHING DOCUMENTS
LEP includes a fast and comprehensive indexed search available from the ‘Search’ tab. LEP search
engine applies a query across the full text index of all documents in the applicable case. The search
results page presents users with a list of documents that match the search terms.

Doing a Simple Search
Navigate to the ‘Search’ tab at the top of the page and users will be brought to the Search screen. Enter
a search query in the search dialog box and click ‘Search’ or press ‘Enter.’

Display Within Search
Documents that meet the criteria set forth in the search query are displayed in a tabular format. The
search results page can be edited to display different fields (columns). Selecting document hyperlinks will
open the selected file in the Document Viewer.
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Search Options and Types
LEP includes the following search options:
All of the words: Searches for instances in which all of the words specified in the query appear in a
document. A document will only be returned in search results if all of the words in the search term are
present.
Any of the words: Search results will include documents that contain any of the multiple keywords
specified in the search query.
The exact phrase: Search results will only include documents in which the entire search query appears
as entered in the search dialog box.
Boolean: Users can enter a Boolean expression using ‘AND,’ ‘OR,’ and/or ‘NOT’ by applying the boolean
search function. Boolean searches are discussed in more detail below. For example, ‘Plaintiff AND
Defendant,’ ‘Invoice OR Statement,’ and ‘Invoices AND NOT Statement’. Our online help details more
complex Boolean search syntax.
Fuzzy: Returns search results which account for misspellings or errors in either the search query or
document.
Stemming: Will extend a search to cover word variations. For example, a search for the word, ‘apply’
would also find ‘applying,’ ‘applies,’ in addition to ‘apply.’
Phonic: Will look for words that sound like, or are phonetically similar to, the search query. For example,
'Invoice’ will also find ‘Investors,’ and ‘Investments.’

Saved and Shared Searches
A list of all past searches are automatically saved in the
database whenever users enter a search query and click the
‘Search’ button. This action automatically preserves the search
records on the list view under the ‘Recent’ section and creates
filter hyperlinks to open a specific set of documents. Please
note that the default link titles are under the 'Recent Search
YYYY-DD-MM' format, but users can rename them by clicking
on the ‘Edit’ hyperlink. It will also allow users to pin and share
the most frequently used searches or delete existing records.
The Search Quick Links section is divided into three
subsections:
Shared. View the searches shared with all users under this
section. To share or unshare searches with all users in the
current case click 'Edit,' and then when the Shared/Pinned
Searches dialog box appears check or uncheck the 'shared'
icon check-box. Please note that this option will share this
search link with all current users that have access to the case.
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Pinned. To pin searches, click ‘Edit,’ select a recent search by the title and then use the check-box under
the pin symbol. Finally, click 'OK' to save these changes or 'Cancel' to not save any changes made. The
pin icon will move the selected recent search up to the ‘Pinned’ section.
Recent. The search query history is displayed under ‘Recent.’ The Search screen displays the five most
recent searches, but if users click on the ‘Edit’ hyperlink a full list of past searches are displayed.

CASE KEYWORDS
Case Keywords can be accessed from the top menu under 'Case-Case Keywords' by Account Admin
users. Users can enter multiple search terms that will be persistently highlighted in the ‘Hits’ and ‘Text’
document views when the Document Viewer is opened by selecting a document title from a Browse
display page. It will also help when users need to manage a list of terms in a set of documents, without
the need to select filters or open the Search page.

To build a keyword list, click the Edit link and enter the terms to be highlighted. Each word must be
separated by the word "OR" and multiple words must be contained in parenthesis i.e. (Jeff* pre/3 Skilling)
OR Prado OR ("alleg* several") OR Chewco OR ("Raptor I"). Enter terms exactly as they appear in the
document. Up to 50 keywords may be entered. Click the Update link to save. Indexing can take several
minutes. The user will receive a warning if the Index is out of date, meaning documents have been
added to the database since the last Case Keyword indexing. To update the indexing, click on "Index
Case Keywords" on the right hand menu.
Boolean Wildcards. Boolean wildcards are used to expand case keywords, as follows: A Boolean search
word can contain the wildcard characters "*" and "?". A "?" in a word matches any single character and a
"*" matches any number of characters. The wildcard characters can be in any position in a word.
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How to Find Highlighted Terms

Go to the Browse page and click on a document title. To see the highlighted terms, switch to the Html or
Text tab from the Document Viewer.

USING THE DOCUMENT VIEWER
The Document Viewer enables users to view documents stored in a
case in multiple review formats. Additionally, users can apply
document coding, review tagging, annotation, and redaction from the
document viewer.

How to Access the Document Viewer
The Document Viewer is opened by clicking on a document title from the Browse, Search, or Facts &
Issues pages. This will open a full version of the file in the browser with up to ten different document
views available. Additionally, from the Document Viewer users can enter and edit document coding and
data, apply review tagging, and add and edit notes and facts. It also allows users to toggle through up to
25 of the documents displayed in the Search or Browse results without leaving the browser screen
displaying the Document Viewer (the Search and Browse result screens/pages display 25 documents
links at a time to keep the speed of display fast).
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Document Viewer Features
The Document Viewer is divided between a document view on the left and a coded data view on the right.
The left view represents the document itself (in different formats) and the right view includes metadata,
and data that users have added to the database in LEP to describe or categorize the document. These
two views are further divided with tabs.

Document Views
The left side of the Document Viewer can include up to ten tabs, representing different versions of a
document, as described below:

Hits: Highlights the number of times a word appears on each indexed page of the document when
opening the document viewer from search results.
Original: Opens the document in native format (e.g., Word, Excel, etc.) using Microsoft Office or other
native applications that users can open on a local computer. However, PDF files and TIFF collections
(originals) can be displayed without installing additional software.
HTML: Displays the extracted text version of the original documents without using applications outside
LEP. This view will not have any page breaks, OCR and is not a print-formatted version.
Page: Displays paginated documents (multi-page PDFs and TIFFs) one page at a time. This can be
faster when viewing large documents, particularly if users do not need to review all pages.
PDF: Displays the document in PDF format.
Text: Displays the indexed text of a document. This includes OCR text from scanned documents and
extracted text from native documents.
Translated: Displays the translated version of a foreign document, that has previously been translated on
a local computer using a third party translation tool, by human translation, or by using our eDiscovery
Auto-Translation services.
Redacted: Displays the redacted version of a file, either created within LEP or uploaded as a redacted
version of a PDF file.
Annotated: Users can annotate or highlight PDF images or files opened in the Document Viewer
Annotation tab.
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Metadata and Coded Data
The coded data tabs on the right of the Document Viewer are divided into four tabs showing metadata,
coded data, facts and notes, as follows:
Disc(overy): View and edit information typically edited in a document review, including date,
sender/author, subject, and document type. From this tag, users can also access any custom fields that
have been created.
Doc: View and edit document title, description, Bates number, recently viewed documents and other basic
information about a document. Redaction and annotation features can be found here as well.
Notes: Create, view and edit document specific text notes.
Facts: Create, view and edit facts related to a document, which will display in LEP's 'Facts and Issues'
timeline module.

Showing and Hiding the Side Panel in the Document Viewer
When opening any document in the document viewer, users initially see a panel on the right that includes
tagged information about the document, discovery, notes and facts. Users can show and hide the side
panel in the document viewer at the top-right corner of the screen. This enables users to devote more
screen space to a document, while easily getting back to the document, discovery, notes and facts tags
when needed.
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Document Viewer Sections
Email Family
The email attachments uploaded or
processed along with the main
messages extracted from MSGs are
displayed as follows:
The email body and any attachments.
When users click on the title of a
document from the Browse or Search
pages to open the Document Viewer,
users will see under the ‘Related’ tab in the document viewer, a section called 'Email Family' showing first
the email body (envelope icon), and the subsequent documents will be the attachments (paperclip icon).
From the Document Viewer, users can also click on the Original tab to open the native version of
documents. When users choose to view the file under the 'Original' tab, it will give users the option to
download the emails and open them with a specific application related to the file extension (e.g. Microsoft
Outlook).

How to Identify Email Attachments
From the Browse or Search pages users can use the following feature:
1-Select the field 'Attachments'. The result will display which documents in the set are email attachments.

2-Apply filter to 'Exclude Attachments'. The result will bring only the original emails.

Associating Email Families
Users can restore a parent-child document relationship (email families) from a recent production
uploaded to a case using a custom Excel spreadsheet (filename.multidocupdate.xlsx) that will associate
the file attachments with the emails. For further details, please see our help page on upload-metadata,
specifically, the paragraph 'Associating Email Families.'
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Partially Privileged Emails
LEP was purposely designed to code documents consistently, to make sure that when an email body or
attachment is coded Privileged or Work-Product, then the entire family is consistently coded. For
example, if users tag an email as 'Responsive' and some of its attachments 'Privileged', the production
validation feature will detect coding inconsistencies, and also give users the option to expand the entire
email family to either just 'Responsive' or 'Privilege'. If users want to manually separate the attachments
from emails for privilege or work-product purposes, please see our help page on
partially-privileged-emails

Email Threading Identification
Our email threading groups only similar emails (at least 50% the same) as an aid to review of overlapping
content items together. The help page on email threading will help users detect and work with similar
emails which are part of a chain after applying Near Duplication to the documents in the data set.

Exact Duplicates
The Document Viewer also identifies copies of duplicate files, which optimizes the review process and
reduces review inconsistencies, errors and reduces review costs. Users can check which documents are
duplicates from the list under the section ‘Exact Duplicates’.

Near Duplicates
This feature identifies files and emails that are nearly identical, which will be grouped based on a
similarity percentage (50% similar in text content). We offer near duplicates services upon request, and
as a result the case database will be updated with a near-duplicate grouping of documents which can be
viewed from the Browse>Groups>Near Dup Groups section, and the Document Viewer>Near Duplicates
(hyperlinks).
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Coding in the Document Viewer
Users can read, review, & code documents one at a time from the Document Viewer. This is known as a
'linear' review process. Select the documents to review using Filters in Browse or from a Search, and
then click on the title of a document to open the Document Viewer. The Document Viewer allows users to
edit built-in and custom fields and sections in the Doc and Disc tabs. When users open a document from
the Browse, Search, or Fact & Issues pages, a listing of up to 25 of the documents displayed in those
pages will be carried over to the Document Viewer.
In the Document Viewer, users can navigate back/forward in whatever tag view users are in using the
navigation arrows at the top of the page (e.g. Then click on the first document on the page to open the
document viewer to proceed through the next 25 documents, etc. (e.g. '<Viewing 1 of 25:>').
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Once the file is opened from the Document Viewer, users can do the following options:
1- Use the 'Save' Button. Code the current file, and just click on the 'Save' button. Please note this
command will only save the tags applied (e.g. 'Responsive', 'Confidential', etc.), without moving to the
next document.
2-Auto-Advance (check-box): If users want to move to the next documents automatically, then users need
to select the 'Auto-Advance' check-box. This option lets users review, code and advance to the 24
subsequent documents in list. After 25 documents, close the current window and return to the Browse or
Search pages. Advance a page at the bottom of the main table, and then click on the first document in
the page to open the document viewer to proceed for the next 25, etc.

3-'Propagate Coding' (check-box). By selecting that option, all of the coding users applied under the Disc
tab>Coding section ('Responsive', 'Responsive', 'Non-Responsive', etc.,) will be copied from the current
record (document) to all members of an email family, overwriting what was there before.
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Alternatively, from the Browse or Search pages users can select multiple documents and use the Multi
Doc Edit function to code documents simultaneously. In this way, thousands (or millions) of documents
can be coded simultaneously in seconds.
Tips for Coding Documents from the Document Viewer
Do not use the Multi-Doc Edit function from the Browse page and the Document Viewer simultaneously.
Click only once for a function. Multiple clicks can slow or send conflicting instructions to the server.
Changes made in a document window do not update the Document Viewer window automatically. If the
same document is open in multiple windows, modifications may be cancelled out by an open window.
Section Preferences
To expand sections and preserve expansion preferences, open a document in the Document Viewer, set
section expand preferences, and click Save (unclick auto-advance to stay on the document).
Advance documents or close and reopen the Document Viewer.
Document Types Supported
LEP supports over 100 file types. These include Adobe's PDF file format, native file types such as Word,
Excel, PowerPoint, and other Microsoft office file types. Graphic file types include JPEG, BMP, and TIFF.
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Rotate Pages
All documents in LEP are read-only. The only way to permanently change the rotation of a document is to
download it, change the rotation (through Acrobat Professional or some other PDF editing software) and
then re-upload the document to the case.
Download Files
LEP supports downloading documents from the Document Viewer.
How To View Audio or Video Files Uploaded to LEP
To open and view audio or video files such as WMV, WMA, MP3, AVI or MP4, click the link. Once the file
is open from the Document Viewer page a new window will give the option to open or save the file to
desktop. Depending on the size of the file, the user will see a message giving the option to either click on
the Switch to Page View or Stay in Native View button. A link will be displayed giving the option to save
or open the files locally.

How to Find Highlighted Terms
Go to the Browse page and then click on a document title. To see the highlighted terms show up select
either the ‘Hits’ or ‘Text’ document view tabs within the Document Viewer.
The Hits tab is located in the upper-left of the Document Viewer. It will include a synopsis of the part of
the document that contains a search hit with the hit word highlighted. This tab will only be available in the
Document Viewer when opening the document from the Search page.
Click Text to switch to the Text tab and Page to switch to the Page tab for the current page in the hits
result.
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CREATING REDACTIONS
Users can modify the PDFs opened in the Document Viewer page, removing portions of the file for
privilege, confidentiality, or other privacy reasons. Redacting a document in LEP Redaction Editor does
not just obscure the image or text, but digitally removes sections of the file, and re-OCRs the associated
text layer, so that viewers of the redacted version can no longer see or search for the redacted portions.
Users can either redact documents directly within LEP or manually upload documents that have already
been redacted. (If users redact using another tool and upload, users should ensure that the text portion of
the PDF file also removes redacted text, and the PDF editor does not just obscure the image layer of a
document). When creating a Production in LEP the redacted version of the document is produced, not
the unredacted PDF version.

Redacting Using LEP Redaction Editor
Open the Document Viewer for the document to redact. Then select ‘Open Redaction Editor’ under the
‘Doc’ tab on the right side of the Document Viewer.

When users open the Redaction Editor page, the message 'Redaction images are being created’ will be
displayed. Refresh the current page to display the file to be redacted (this can take a few seconds to a
few minutes for very large documents being created). This process creates a new image PDF version of
the document and removes text layers in the redacted version of the document. Once the Redaction
Editor is open with the new redacted version, a user should select the area to redact with the mouse. This
will draw a gray box around the selection and automatically open the 'Edit Redaction' Box. In the
Redaction Text enter any custom message that will display over top of a redaction. This could be
‘Redacted’ or something more specific.
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Once the portions of the documents needing redactions have been concealed, click on the 'Save
Redaction' button and the area of the document selected will be covered by a redaction with the custom
message.
The 'Undo' button gives users the ability to go back to the 'Redaction Editor
Page' and edit redactions.
When all redactions have been applied, review final redactions and then
click on the 'Apply Current Redaction' button. This action will then prompt
users to 'Refresh' the page to create the final Redacted PDF version. Wait a
few seconds for the processing queue to complete the redaction task. Users
should expect some delay when creating a redaction image, especially if users are redacting large PDF
documents, as this is a resource intensive process. A new, redacted version of a PDF is being created
and re-OCRed to ensure the complete elimination of redacted content. Refresh after several seconds
(minutes for larger documents) to view the redacted document. When completed, close this window,
return to the Document Viewer, and refresh to find a new “Redacted” document view tab.

Once the redaction is complete, the 'Redacted' document view tab will display in the Document Viewer
page. Users can still view the unredacted document views in the PDF tab. Please note that once users
apply redactions to a document, it occupies the processing queue for the case and further redactions are
not allowed until the current one is complete.
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Uploading Your Own Redacted Versions of Documents
Users can also upload their own redacted versions of documents created using a local redaction editor.
Care should be taken to ensure that the local PDF redaction editor removes image and text layers of
redacted text, and does not just obscure the image. To create redacted documents outside of LEP, do the
following:
● Download the PDF version of the document to be redacted from the Document Viewer.
● Redact locally. Note: the number of pages must remain the same.
● Upload the redacted version from the Document Viewer, Doc Tab, Upload Manual Redaction link.
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Showing and Downloading Redacted Documents
From the Browse and Search pages users can display the built-in column 'Is Redacted.' Users can also
apply a filter with the 'Show Redacted Only' field and see only documents that have redacted versions.

Redacted versions of documents can be downloaded in two ways:
●
●

Individual redacted versions of documents can be downloaded from the Document Viewer,
Redacted tab, and from within Adobe Acrobat reader)
Redacted versions of documents can be downloaded in bulk by filtering on Redacted documents
in Browse or Search and then creating a Briefcase. The Briefcase will include the redacted
versions of PDFs created in the REDACTED folder.

WORKING WITH TRANSLATED DOCUMENTS
Translated View of Foreign Language Documents
The Document Viewer displays a 'Translated' tab for foreign language documents that have previously
been translated on a local computer using a third party translation tool, by human translation, or by using
our eDiscovery Auto-Translation services. Users will have access to the translated version by clicking on
any link to the foreign document in LEP, such as from the 'Search', 'Browse' or 'Facts & Issues' pages.
Our comprehensive search index will also generate separate index terms for the original and translated
document to allow searching from the original language or English.
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Auto-Translation Services
LEP also offers auto-translation services to handle a large volume of foreign documents uploaded to a
case. Please contact an eDiscovery Solutions Director for an Auto-Translation Services quote.

Manual Upload of Translated Documents
Users can manually upload documents already translated by using a preferred translator tool or those
translated by a human translator. Please note that the translated version must be saved in a PDF file
format. Translated documents manually uploaded will not affect or automatically delete the original
foreign language files, but instead add to the document record.
The step by step instructions (below) assume that users have already uploaded foreign documents to the
case in LEP and also translated them on a local computer.
●
●
●

●
●
●

From the Browse or Search pages, click on the title of the document to which users want to
upload the manually translated version.
Navigate from the top menu to the Translation section (Document Viewer>Doc Tab).
Click 'Upload Manual Translation ' hyperlink. This action will take users to the 'Translator Editor'
page.

From the 'Translator Editor' page, click on the 'Browse' link to select previously translated
documents version.
Click on the 'Upload' button to upload directly in the Document Viewer page, Doc tab>Translation
section.
Translated document will be uploaded. Users can close the current page and refresh/reload the
document view page.
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●

Once the upload is completed the 'Translated' tab will display its version in the Document Viewer
page, while users can still view the original from the Page, Doc and Original tabs.

Downloading Translated Files (one at a time)
From Document Viewer->Translated tab, use the Acrobat control icons to download the Translated
version outside of a production. From Document Viewer->PDF, use the Acrobat control icons to
download the version which has not been translated. Translated documents are not part of the Download
Briefcase generated from the Browse and Search pages. Only the foreign language versions will be
available under the ORIGINALS and PDF sub-folders.

Which Version will be in a Production?
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Only the PDF and Original versions of the document will be included in a production under the
ORIGINALS, PDF, and TEXT sub- folders.

ORGANIZING DOCUMENTS WITH SAVED FILTERS,
FOLDERS, & NOTES
Working With Folders
To view subfolders please go to the ‘Management>Manage Folders’ page. When users upload folder
structures (nested sub-folders) in a .zip file to LEP, by default all the files along with their sub-folders will
be automatically assigned to a general folder called 'Unassigned.’ The upload will carry over the same
subfolder titles that users can edit under ‘Management>Manage Folders.’
Please note that LEP does not map to folders during document upload and instead it is recommend that
users use Saved & Shared Filters to organize and work with sub-folder structures. After uploading data, if
there is a nested folder structure in the uploaded container files (e.g., Zip, PST), then the paths will be
automatically mapped to the Source File Path field in the application. Contact Professional Services if
additional work is required for this folder preservation. Original folder path can also be seen from the
Source File Path field.

Users access the actual files assigned to subfolders from the Browse page under the Folder Quick Links
section. A new window (folder tree view) will be opened and list all folders that have been set up in the
selected case. Users can assign documents to specific folders within the case as follows:
●

From Browse or Search, select the documents and code using the ‘Multi Doc Edit’ Function, since
‘Folder’ is a built-in field.
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●

From the Document Viewer under the Doc tab.

Folders vs. Custom Doc Fields/Tags
A key disadvantage of using Folders in a litigation database is the need for single documents to be
identified with many tags. Folders are one-dimensional (cannot multi-tag) and they work well as long as
users have one criterion in a case and for the documents (e.g. 'Transcripts'). But as soon as users want
one transcript with exhibits to belong to multiple categories such as; 'Transcripts', 'Transcripts to Send to
Client', use of Folders causes problems.
For example, one file can be tagged as 'Hot' document, identified with deponents 'Smith' and 'Jones',
liability issue: 'negligence'. This can be easily done with Fields/Tags, but cannot be done with Folders
without duplicating the file. Duplication of files in LEP or any litigation database program should be
avoided as it leads to inconsistent coding and other problems.
Custom Doc Fields/Tags allow for multi-dimensional coding from the Browse and Search pages. One
document can have as many tags as needed without creating duplicates in the case, including a number
of built-in Fields such as 'Responsive,' 'Confidential,' 'Key Document,’ etc. LEP allows users to filter or
apply searches to multiple criteria to group documents. Filters, particularly if saved and named, act a lot
like a folder but with more functionality and without the restrictions.
The original folder path of a document when uploaded from a .zip is saved read-only on the 'Original File
Path' field and can be accessed and filtered. Saved filters can be created as well.
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Folders vs. Doc Fields

Folders

Advantages

Disadvantages

Folders are familiar and simple, if not
very functional.

A document can only live in one folder at a time.
If the same document needs to be located in
multiple folders it will be necessary to re-upload
the same file, introducing duplicates, which
should be avoided.

Folders can be created automatically in
LEP on upload of a ZIP compressed file
containing an existing folder structure.
The upload will carry over the same
Use of Folders can encourage users to create
subfolders titles. See
duplicates of files to get desired file organization.
Management>Manage Folders for more
information.
Finding documents in highly nested folders is
difficult.
A sub-folder and all of its contents can
be moved to another location without
Users cannot apply Search within sub-folders.
using multidoc edit.
Doc
Fields

Multidimensional coding. One
document can have many tags as
needed without creating duplicates in
the case.

More work to set up than Folders, so Folders may
be adequate in small, simple cases.
Folders can be automatically created on upload
but Fields/Tags and Saved Filters cannot.

Display multiple Coding fields at the
same time in Browse, Search or the
Document Viewer.
Filter or apply searches to multiple
criteria to group documents. Filters,
particularly if saved and named, act a
lot like a folder, but with more
functionality and without the
restrictions.
When uploading Native files, LEP
automatically extracts metadata and
codes to built-in fields. For example,
Outlook email Sender, Date Sent, Date
Received, etc. is automatically
extracted and fielded to built-in fields in
LEP.
Coding may be included in a case from
a load file (e.g., Concordance or
Summation) and these will be coded to
fields, not folders.
The original folder path of a document
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when uploaded from a Zip is saved
read-only on the Original File Path field
and can be accessed and filtered on
and saved filters can be created.
They can be accessed from the
Browse, Search, Document Viewer and
Case>Add Case Documents pages.

Creating & Sharing Notes
Keep track and share notes (virtual sticky notes) about pleadings, transcripts, and other documents. To
get to the Case Notes page, click on 'Case Notes' under the 'Analysis' tab. It is an effective way to
organize thoughts, comments, and tasks related to a document being reviewed.

The 'Export to Excel' button allows users to save the current view in the browser window to an Excel
spreadsheet format. To complete this function:
●
●
●

Select the notes users want to export by checking the box next to the note.
Click ‘Export to Excel’
In the dialog box, choose ‘Save’ and the note will then be saved in an Excel file.

Notes can also be created and viewed in the Document Viewer by selecting the Notes tab.
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DOCUMENT REVIEWS
Once users have collected all relevant documents and uploaded them into LEP, users may wish to bundle
documents into smaller groups/batches to manage a review workflow. For example, a review of 500,000
documents that must be done quickly and/or requires extensive searching and culling is more easily done
by creating Review Sets. This section will discuss how to manage, code, and navigate through document
review workflows.

Preparing a Review Set
A Review Set is a group of documents culled from the collection of documents. Review Sets are useful
when users have a team of reviewers to review a large set of documents. Individual Review Sets will be
created by a case administrator and assigned to reviewers and can only be created one at a time. The
size of each Review Set will vary according to the needs of the project.
To create a Review Set:
●
●

Navigate to the Account tab
Click ‘Manage Review Sets

●

Click ‘Create New Set.’ The default title for any new Review Set will always start with the word
'Review Set' and the current date MM-DD-YYYY, as follows:
'Review Set 12-08-2015'. Users can also edit the review titles (e.g., ‘Enron Review 05-11-2014’).
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●
●
●
●

Navigate to the Browse screen.
Select the documents to be added to the review set by checking the box next to the documents.
On the left side of the screen, choose the “Review Sets” drop down. Click on the appropriate
Review Set.
In the pop up box, click ‘Add Selected Docs’ and add files to the Review Set from the Browse
Page.

● When completed, a message will appear on the top left side of the screen reading
‘Docs added to review set.’
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●

After users assign the documents to a Review Set, navigate to the Account tab and click on
Manage Review Sets.
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●

When ready to start reviewing documents, click 'Start Review.’ This will make the Review Set
available to Reviewers from the Discovery>Review Batch Page

How To Start Reviewing Sets
After an Account Admin creates a Review Set, the team of reviewers can go the Discovery>Review Batch
page and filter on the ‘Review Set= Review Set XX-XX-XXXX’ (e.g., ‘Review Set 12-08-2015’).
This action will open the Review Set and as soon as “Start Batch” is selected, the document viewer will
open up, displaying the document to be reviewed. The Review Set will check out an entire email family
at the same time to ensure that a reviewer is reviewing emails in order (email, attachment, attachment)
and also that no other reviewer is able to pull up part of that email family during their review.
The number of documents remaining in the review set will continue to decrease as the review progresses
and is being updated in real time. This number will be visible in the upper right hand corner of the
document viewer above the coding choices.
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If a reviewer needs to exit the review set before the review is complete, they may select the Exit Review
Set button at the top of the doc viewer and will be taken back to the Browse screen. A reviewer may
return to the review set later and continue reviewing until complete.

Viewing A Review Set's Status
The ‘Status’ field available in the Review Set panel shows the stage of each Review Set created and not
deleted as follows:
Pre Reviewing. The review set has just been created and not activated (‘Start Review’ button)
Review Set available to reviewers. After adding all document to a particular review set and clicking on the
button ‘Start Review’ from the Manage Review Sets tab, the review set will be available to reviewers from
the Browse.
Review Complete. The final stage of a Review Set.

Review Tracking
LEP allows users to keep track of documents reviewed by multiple users in the case. Users will be able to
check the documents reviewed ‘Daily,’ ‘Hourly,’ by 'Doc Count,’ 'Pages,’ 'Gigabytes,’ and 'Activity.’ Please
note that reports generated under this page will be linked to the documents marked as 'Review
Status>HasBeenReviewed' from Browse and Search or 'Document Reviewed By Me' from the ‘Document
Viewer>Disc’ tab.
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Please note that users must have admin rights to access Review Tracking from the Account page. This
feature allows users to create grid graphics and reports, and also export the results to an Excel
spreadsheet.

PDF Splitting & Page Removal
When users upload a large PDF that involves multiple documents not broken out (unitized), users can
use the PDF Split function to separate individual documents from the top menu under
'Management>Manage Split PDFs.’ This page will create a new PDF document made up of only the new
PDF pages users select, without affecting the original document.

Users can also remove specific pages from a PDF document and make a copy showing only the pages
users have selected. It will not split or delete the original document, but create a new one excluding
certain pages. This feature allows users to work with a large PDF that involves many individual
documents that have not been individually broken out (unitized), especially if users want to reference
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pages in large documents. users can upload the entire PDF and then use LEP PDF splitter to break out
smaller individual documents when needed.
To manipulate a PDF (split or remove pages), open the PDF document to split in the Document Viewer.
(Note that this section is only visible for documents and no other document types). On the lower right of
the Doc tab is a pane entitled 'Split Document.' Open that and type in text instructions for how to split.

After adding the task from the ‘Document Viewer>Doc’ tab, please go the ‘Management>Split PDFs’
section under the ‘Doc’ tab, open the Split Documents Manager and then locate Split Task. Next, close
the Document Viewer and navigate to the Split Documents page (Management>Split PDFs). These can
be as simple as the range, or more elaborate if necessary.

This section is free form and can also contain information such as new file names, or which split
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document should be marked confidential, privileged, etc. by clicking on the ‘Edit’ hyperlink from the main
table.
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DOWNLOADS, PRODUCTIONS & LOGS
DOWNLOADING DOCUMENTS INDIVIDUALLY OR TO A
BRIEFCASE
This section will briefly overview downloading options, which are described in more detail later in this
Guide. users can download documents in four different ways in LEP.

Single PDF from the Document Viewer
LEP allows users to easily download a PDF version from the PDF
document view. The 'PDF' document view tab is located to the upper left
of the Document Viewer. users can work with documents in a fully
functional version of Adobe Acrobat Reader and download PDF
documents into a local drive by selecting the ‘Download’ icon or just
right-click on the document and select ‘Save Page As’.

All Versions of a Single Document from the Document Viewer
Users can download all versions of a single document from the
Doc Viewer by using the ‘Export to Briefcase’ hyperlink. The
download briefcase will include the Original version of the native
file, PDF version of the corresponding file, Redacted version (if
available), and Annotated version (if available).

Download All Versions of Multiple Documents as a Briefcase

Download multiple documents (and versions of a document) by creating a Download Briefcase. From the
Search or Browse pages, users can access and download groups of documents that users have
selected.
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Users can create download briefcases of selected documents to save to a local desktop from the Browse
or Search pages. From the Document Viewer users can download a single document by clicking on the
'Download' button.

For each export of documents users can enter the following information:
Title: Unique Name for the briefcase being downloaded. By default, the title will display as 'Briefcase
MM-DD-YYYY.’
Comments: Specific comments related to the download.
Name Files: Users can name the files using the 'Doc Title,' 'Bates Numbers,' or 'Doc Dates' field. Please
note that standard date format must be 'YYYY-MM-DD' (e.g., 2013-09-19).
Custom Designation: Users can enter full text messages usually up to 100 characters (e.g.,
‘Confidential Subject to Protective Order’). For further assistance, please see section called 'Preventing
Inadvertent Disclosure Of Confidential Information' under the Bates Stamp Help Page.
Bates Stamp: A checkbox, 'Bates Stamp Pages of PDF documents’ is present and, if checked, the
Bates
numbering
from
LEP
database (see Docs tab in
'Document Viewer') will be applied
to all pages of PDF documents
included in the download. Please
note the following with this function:
● Adding Bates numbering to
a large number of documents can
take a long time, or even time out. If
this happens, users can break into
smaller batches and download
again.
● If a Bates number is already
on the PDF image then this function
will write the Bates again (which
may not be intended).
● This function is meant for a
limited number of documents, such
as preparing for a deposition, and is
not intended as a substitute for
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creating a document production.
Doc ID: This is an internal string of numbers automatically generated to keep track of each file
uploaded/processed. It identifies documents printed before Bates numbers have been applied (e.g.,
during review process, before a production). It also allows multiple productions (different Bates) of the
same document (same Doc ID and control number).
Notification: This option will notify users by email (user email address) when the Briefcase download is
complete. Users don't have to wait until the download has completed or keep checking the Download
Briefcase page (it will be part of a .zip file). Once saved, users can copy it to a flash drive, DVD or CD, or
create a private link (shareable with outside parties or staff who are not registered users with an LEP
Account.)
Folders Structure Included in the Briefcase
A downloaded briefcase will include a folder entitled Briefcase and the following sub-folders:

Originals: Folder designated for all the native files (Word, Excel, JPG, PGN, etc.).
PDF: The PDF version of the correspondent native file (Word, Excel, etc.).
Redacted: Any redacted versions of the files. Note that MSGs and container files will also be part of the
Download Briefcase in the ORIGINALS sub-folder. The Briefcases are not intended for productions and
do not withhold Privileged or Work Product documents or natives that are associated with redacted
documents.
Annotated: It will also include any annotated versions of the files.
Translated: It will include any translated documents.
Merge: It will include any merged PDFs.

SHARE DOWNLOAD BRIEFCASE
LEP allows users to share sets of documents with persons outside LEP by downloading documents to a
briefcase, and then sending the files using a shared download link.

How to Share Download Briefcase
1-Go to the Case>Download Briefcase page. The main table will display all the briefcases (from current
and all cases in account) that users have selected to share or download.
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2-A new window called 'Edit Briefcase' will be opened. Rename the Title and click on the check-box
where it is written 'Allow users without access to LEP to download this Production' and then click
'Update'. After users select the checkbox and update any Briefcase, the hyperlink will only become active
(Link).

3-Documents can be shared by copying the URL or web address from the ‘Shared Download Link’ and
pasted into an email to be sent out The email recipient will then be able to download the documents (zip
file) to a location on his/her computer.
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When users click on the button 'Go To Shared Download Page', users will be automatically redirected to
the following page:

This page also allows users to copy the URL link or click on the 'Click here to download' link. Progress is
also shown for the entire download based on an individual’s Internet Speed and size of the .zip File.

CREATING PRODUCTIONS
Document reviews for production are generally done in response to a 'Request for Production of
Documents’ (although it may be called different things in different jurisdictions). LEP allows users to
prepare a Discovery Production Set, including Bates stamping, and save the documents in the production
set to aq local desktop (it will be part of a .zip file). Once the Discovery Production Set is saved, users
can copy it to a flash drive, DVD or CD, or create a private link (shareable with outside parties or staff
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who are not registered users with an LEP Account). In LEP users can create two types of production:
1-Standard PDF. Will take native files as input, convert processable files to text-based PDFs (for
supported text-based native files), and image only PDFs of supported image based native files.
2-Standard Plus TIFF. Will take native files as input, convert processable files to single page TIFFs, and
use extracted text (no OCR) to create single page corresponding TXT files.

Production Steps
Once documents have been coded and users are ready to produce, follow these steps to create a
production:
1- Go to the Document Production window from the menu ‘Discovery>Document Production.’ Create a
Production Title from the Production Job page. In order to start a new production, first users must click
'Start New Job' to create a virtual briefcase designed to produce specific documents. users also must edit
the Production Panel (Comments, Bates Beginning, Production Type, etc.).

2- Add Documents to the Production. Go either to the Browse or Search pages. Filter on the set of
documents users want to produce (Filter>select Filters), select the files and then open the section
'Productions' to choose a production by title using the 'Add Docs to Production' option. A new dialog box
will be opened and ask if users want to add the selected files to the Production. To complete the task,
please click on the 'Add XX Docs' button.
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3- Validate the Production; to detect files that are inconsistently
coded during the production. If the production does not validate,
this will require re-examination of files to identify the inconsistently
coded documents. Before the production can be run, these
inconsistencies must be addressed.
4- Run the Production. Review the Production Panel and then click
on the 'Run The Production Job' to lock the current set of
documents produced. Please wait until the production is created.
The time to create a Production depends on the number of
documents. The Production will be available for download from the
same page.
Please also note that once users run a production it will not be possible to add or remove files. Users will
have to start a new production if there are any changes required.
Preventing Inadvertent Disclosure Of Confidential Information - MSG and Container Files
LEP production includes native attachments to emails and natives expanded from Zip and other
supported container files. These will be found in the Originals folder. However, the Originals folder will not
include native emails unless the Include Native Emails option is selected as discussed above. Best
practice is to omit the production of native emails. This is done to ensure that native versions of
privileged, work product or redacted documents nested inside of container files are not inadvertently
produced.
In such cases where native email files must be produced, select the Include Native Emails option.

ADDING BATES NUMBERS TO DOCUMENTS
General
Our system will apply Bates-stamp to documents as part of a production generated in the
Discovery>Production Job page, due to the fact that users may want different Bates for differing
productions in a case.
Quickest way to get Bates on Documents
●
●
●
●

Create a Production
Select all documents users want Bates on in the Browse page.
Run the production
Download or delete the production.

NOTE. The Bates Number shown on the Browse, Search and Document Viewer pages reflect the Bates
Number the document was assigned in the last production. Also, if users run multiple productions, the
Bates Number for any document is stored with the production so users can download it multiple times
and it will retain the Bates number that it had when the production was first created.
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Bates Applied to Logos & Other Small Images
Our automated file processing will take small images and apply them to blank PDFs (8.5" x 11" standard
letter size paper) without the font running off the page, and the Bates number will also be applied to the
Bates name.
Benefits of Applying Images to a Blank PDF:
● Better handling of logos, signature images, etc. in email.
● Improved legibility of Bates stamping, Confidentiality, AEO legends, etc. at a page-level.
● Avoid waste and extra costs for not producing all the attachments without proper review. This
could raise many questions as part of a review process and require that the missing attachments
be retrieved. The usual practice is also to produce all parts of an email container, including
attachments. This is what is done in LEP standard load files.
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Retaining Bates Numbers from Previous Productions
Bates Range
The Bates Range of documents in a Production Job being prepared, and Privileged documents withheld,
is not determined until the job is completed. It's a common practice to have different Bates prefixes for
associated productions to allow independence of Bates ranges.
Associated Productions
Users have one option when creating associated productions:
1- Run one production at a time. In this case, users will get the
Bates Range (for produced and withheld documents) on
completion and that range can be used to generate the start of
the next production. The existing Bates Range section in the
Production Job page helps users keep track of existing Bates
sequence, prefix and range as well, from previous productions.
If users need to re-run a production for some reason (e.g. 'needed to add more files to production', etc.),
users can simply start a new production from scratch. Each production run will set the Bates Number and
if a document was part of a previous production, its Bates number will be updated to reflect the latest
production.
The Bates Number shown on the Browse, Search and Document Viewer pages reflect the Bates Number
the document was assigned in the last production. Also, if users run multiple productions, the Bates
Number for any document is stored with the production so users can download it multiple times and it will
retain the Bates number that it had when the production was first created.
2- If productions are run simultaneously in different cases (only one production can be run at a time in a
single case), then a different Bates prefix can be applied. For example if the first production has a Bates
prefix of 'ABC', then the second production could start with 'ABC2' or the like, and number 1.
Overwriting Existing Productions
It is possible to write over Bates numbers of documents in productions to different parties so that each
production will have a contiguous range, but the prior Bates numbers will need to be accessed. This is
possible as described below:
1-Create and run Production 1
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2-From the Management>Manage Custom Doc Field create custom field section for 'Prior Bates
Numbers' and coding sections (text-box for Production leading letters, e.g , TBS, DEF, LMN).

3-Use Excel metadata update to copy the Bates leading designation and the number (with leading '0's
into custom field 1).
4-Concatenate the columns using leading '0' (e.g. '=C2&" "&"000000"&D22 the number'). The number of
0s will need to be adjusted as the number increases. After creating the number, the field in Excel needs
to be copied with a 'copy values' step.
5-Upload the finished Excel and update the Bates custom field using our Coding in Excel & Upload
Metadata feature (e.g. eDiscoveryPlatform.multidocupdate.xlsx).
6-Create and run Production 2, etc.
NOTE. In the option above, the Prior Bates number will be available in the Doc Viewer and in Browse.
Without doing this the Prior Bates number will be available as part of a production download in the range,
or the actual documents if not deleted.

Specific Bates-Numbered Production
LEP does not automatically allow for production of the specific Bates order. Within the application, it
Bates numbers by 'Doc Title' as the default option, and any withheld (privileged) documents will be
logged after all of the documents to be tangibly produced have been processed. This means that the
production set is broken into two parts. The first part is the documents to be produced and the second
part (anything 'Privilege' or 'Work-Product') is put into the withheld.
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LEP also gives users the ability to sort their production order by Master Date, Source File Path,
Custodian, or a Custom Field.

Production Validation
This feature is intended to detect files that are inconsistently coded during a production, exposing the
ones that require intervention before they are filed with courts or delivered to the other side or expanding
files that were supposed to be tagged as 'Responsive', as well (e.g. email attachments). For example,
users will be able to identify if there are email attachments that were inadvertently marked as 'Privilege';
therefore not included during a production.
The validation will show the total inconsistent documents:

‘1. Responsive’: Confirms that attachments to files marked responsive are also appropriately marked as
responsive.
‘2. Privilege’: Ensures that there are no attachments to files identified as privileged set to be produced.
‘3. Work Product’: Validates that there are no attachments to files marked work product set to be
produced.
‘4. Validated’: Confirms that all validation steps are complete, which will allow users to create and
download the production.
Production Validation is located on the top menu under the Discovery tab.

Lexbe eDiscovery Pla orm User Manual 2-2018

Page 72

Downloading Productions
From the Production Job page, users will be able to prepare and download a discovery production set in
a compressed .zip file. LEP’s production capabilities also allow users to convert and produce PDF and
TIFF documents on the fly, including automatic creation of compatible loadfile formats for both
Summation and Concordance.

SECURE ONLINE PRODUCTION CAPACITY
Sharing Productions
1-When users click on the link 'Edit,' the Production Panel will display a checkbox called 'Allow users
without access to LEP to download this Production' and then click 'Update'. users will also be able to edit
the Production Title Comments text-boxes.
2-After users click on the link 'Update', the production panel will display an active hyperlink to indicate
that users can share a selected production:
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3-Productions can be shared by clicking the shared link and copying the URL or web address from the
‘Shared Production Link’ page and pasting it into an email to be sent out. The email recipient will be able
to download the documents (.zip file) to a location on his/her computer.

Similar to the Shared Download Briefcase feature, when users click the button 'Go To Shared Download
Page' it will automatically redirect users to the following page:

Production Throughput
Users should expect an approximately 10 GBs/day rate (~200,000 pages) within an LEP account
(combined across all cases) to create Productions (including Bates numbering) for Standard PDF
productions and 2.5 GBs/day rate (~50,000 pages) if TIFF Productions are selected. This does not
include the time it will take to download the production which will be determined by the speed of individual
internet connection. PDF productions will be approximately the size produced, while TIFF productions
expand significantly (generally 3-10X). Production creation increases monthly hosting cost as it uses
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more storage, for at least one month, and longer if not deleted after creation. For larger productions,
please contact us for an eDiscovery services quote. As a managed service we can process very large
productions within days.

PREPARING PRIVILEGE & REDACTION LOGS
LEP facilitates the creation of Privilege/Work Product and Redaction logs, using standard logs, or
customized using any standard or custom fields users create.

Creating Privilege Logs
LEP automatically generates a standard Privilege Log for all of the productions users create. A privilege
log will list all of the documents marked privileged for review by opposing counsel. The following fields
are included in the standard Privilege Log report:
●
●
●
●

Doc Type
Attorney-Client Privilege
Work Product
Confidential, etc.

Selecting Fields. When users select a production, the main table displays certain fields by default (e.g.
'DocType', 'Attorney -Client Privilege', 'Work Product' or 'Confidential') that help identify the documents
withheld due to privilege, meeting the privilege log requirements in the vast majority of cases.

However, this feature also allows the user to select additional fields to include in the report, allowing the
user to customize the lauserst of a privilege log similar to the Show Fields in the Browse or Search
pages. To customize a privilege log, click on the Show Fields link.
This action opens the Show Fields dialog box, where users can select numerous fields by checking or
unchecking fields to display in the privilege log. Additionally, custom fields may be selected for special
needs.
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When complete users can export the log as an Excel spreadsheet. After running a Production, the log is
available for download from the Discovery>Production Job page.

Users can filter on a Production and generate a report log that displays all documents in the case that
have been marked 'Privilege' and subject to 'attorney-client privilege' or 'attorney work product.’ The
Privilege Log is also located under the Discovery Page. In either case users can export the values to an
Excel spreadsheet for finalization of the Privilege Log.
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Once in Excel, users can further modify the privilege log as may be needed and print or save as a file for
delivery to an adversary. Columns that users do not wish to deliver should be deleted in Excel. The dates
for the Briefcase Export are in the US format. (Excel allows sorting on any of the exported fields).
(NOTE: If delivering an Excel file, make sure all comments, 'fast saves', metadata saving, or anything
else that might provide confidential information or work product, or evidence of prior versions has been
turned off or removed).

Creating Redaction Logs
LEP enables users to redact documents in the Document Viewer or upload documents redacted locally.
LEP displays the redacted version in the Document Viewer under the Redacted tab. Only the redacted
versions of documents will be included productions under the PDF, TIFF, and TEXT sub-folders. LEP
automatically withholds the underacted version of documents from the ORIGINALS sub-folder.
PDFs must be redacted within the LEP Redaction Editor or uploaded within the Document Viewer>Doc
tab>Redaction section, for the production feature not to include unredacted documents.
Documents may be redacted by users for many reasons, based on user needs, including removal of
confidential information and removal of Privileged or Work-Product from documents otherwise to be
produced.
How to Filter on Redacted Documents
When a document is redacted in LEP using the built-in capabilities, a field entitled Show Redacted Only
is automatically set. Filter on this field in Browse or Search as follow:
Select Filters>Select Custom Filters from the left margin. Select which filters to apply from the drop down
menus. Click Apply and the document set will be filtered in Browse.
The user may also select the field Is Redacted from the Show Fields>Built-in fields available from the
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Browse and Search pages.
How to Keep Annotations of Why a Document is Redacted
In order to track why a document was redacted for a Redaction Log or otherwise, create a custom text
field as follows:
1-Go to the Management>Manage Custom Doc Fields
2-Click the Add Coding Section hyperlink and create section title named Redaction Detail
3-Click the Add Coding Field hyperlink and create a text box title named Reasons for Redaction
When redacting documents the user may add the custom tag Redaction Detail>Reasons for Redaction to
the files that have been redacted. This may be done individually from the Disc Tab or with the Multi Doc
Edit function from the Browse or Search pages. Select multiple files to tag by applying text to a text field
for redaction reasons, or by marking the check-box if used.
Create a Redaction Log
From Browse or Search the user may filter on Custom Doc Fields to include specific information about
the documents being redacted, and this can be downloaded as a Redaction Log as follows:
Step 1-Choose Fields for Redaction Log
Choose the fields for the Redaction Log. We suggest:
Custom Doc Fields. Related to the redacted files (e.g. Redaction Detail).
Bates. This field refers to the Bates number of the redacted document.
Confidential. Documents marked as such.
Document Date. Indicates the date of a document.
From. Indicates the author(s) of the document.
To. Indicates the recipient(s) of the document.
Cc. Indicates the recipient(s) copied.
Bcc. Indicates blind carbon copy.
IsRedacted. Indicates a document is redacted.
Redaction Detail. Custom Text Field created to describe why a document was redacted.
Step 2-Apply Filters
Go to Filter>Select Filters and apply filters to show only redacted files.
After coding documents and selecting specific fields, use filters to narrow down results to a specific
division or document to exclude certain files. This feature also allows the user to save and share filters
and fields in LEP. For example, to find documents redacted as as part of a certain Production, select the
Production in question from the filter to show redacted documents within that production.
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Step 3-Save and Share Filter
To save and share this filter, go to the Filter Quick Links section. Filters are automatically saved after
application from the Browse or Search pages and are listed under the Recent section with filter hyperlinks
to open specific set of documents. The default link titles are under the Recent Filter YYYY-DD-MM
format. To rename, click the Edit hyperlink (e.g. Redacted - Confidential).
Step 4-Download and Save Custom Redaction Log
Select the documents shown with the filter and click Export To Excel.

Download Privilege Logs
'Privilege' and 'Work Product' files are not included in the set of documents users produced
(Discovery>Production Job page). However, from the Discover>Privilege Log page users can still
download and save those files to the desktop by clicking on the 'Download Withheld' button.
Privilege Log (Custom)
The Privilege Log page displays standard built-in fields that
will help users identify the documents withheld due to
privilege, meeting privilege log requirements in most cases.
However, in LEP users can also customize the contents of a
Privilege Log from the Browse page to include additional
information and information from custom fields users create.
A Custom Privilege Log could be expanded with either LEP
Built-In Fields, or with custom fields users might create. The
available built-in fields are numerous and may address users
needs. users may also create additional custom fields for
users own needs. These may be checkbox fields or
text-based fields.
The following are examples where a
Custom Privilege Log could be used:

●
●

Use one or more custom text fields with explanations of attorneys, staff, or outside reviewers’
notes of why a document is privilege or work product.
Specific identification of multiple privileges claimed. Use LEP ‘Privilege’ field to identify that some
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privilege is claimed, and then a custom field to specify which one (e.g., ‘attorney-client’ or
‘settlement’).
A custom text
field or multiple checkbox fields
could be used, depending on
the level of detail needed. See
LEP Technical Note on ‘Custom
Privilege Logs’
for more
detail.Redaction Log
LEP enables users to redact
documents from the Document
Viewer or upload documents
that have been redacted locally.
Either type will display in the
Document Viewer under the
'Redacted' document view tab.
Only the redacted versions of documents will be included in LEP Productions under the 'PDF,' 'TIFF,' and
'TEXT' sub-folders, and our system also automatically withholds from production the un-redacted version
of the documents in the 'ORIGINALS' sub-folder. See LEP Technical Note on ‘Custom Redaction Logs’
for more detail.
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PREPARING FOR DEPOSITIONS,
MOTIONS & TRIAL
CUSTODIANS, ISSUES & TIMELINES
Identifying Case Custodians
Users can setup the litigants, deponents, witnesses, and other individuals and organizations in the case
that provide factual information from the 'Analysis' tab. These persons or entities may be custodians of
ESI in a case.

In the Document Viewer>Disc tab>Document Id section, users can also view and assign Custodians.
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Creating Custodians
To create custodians, click the Create New Custodian button. The entry screen contains text boxes for all
applicable fields. Use the Last Name, First Name format (e.g. Smith, Ralph) to complete the Name field
for a custodian for more efficient sorting. When finished, click Update to save the record. The user may
import contact lists prepared using Excel, as noted below.
Deleted Selected Custodians
Select one or more custodians to be removed from the current list. Click Delete to expand the Delete
Selected Items option.
Export To Excel
Select one or more custodians to export from the current list. Click Export to expand the Export to
Excel option. The user may then print the spreadsheet with all the tags related to the custodians after
downloading to Excel.
Assign Custodians from the Add Case Documents
Custodians can be assigned from the Add Case Documents page if they have been created prior to
upload.
Assign and Filter Custodians from Browse and Search Pages
To assign custodians from the Browse and Search pages, select the document(s), click Multi Doc Edit,
select the Custodian field from the drop-down and click Update to complete the process.
To filter Custodians from the Browse or Search pages, go to Filter->Select Filters->Custodian->Select
Custodian.
Delete Custodians Previously Assigned to Documents or Facts & Issues
Disassociate the Custodians previously assigned to documents or Facts in the case using the Multi Doc
Edit feature as described above, and then proceed to delete custodian(s) as described above.
Assign Custodians to Facts and Documents
Custodians can be assigned to facts on the Facts & Issues page. This can be used for associating
custodians with Facts related to witness interviews, depositions and examinations.
Keyword Search
Use the search to narrow down which Custodians are shown.

Creating Facts & Timelines
LEP allows users to create facts, issues, and dynamic timelines particular to a case. Facts can be
grouped to one or more issues. Each fact can link to one or more underlying documents that support the
fact. Facts with dates automatically display in dynamic timelines. To get to Facts & Issues area, navigate
to the 'Analysis' tab. Then click on ‘Facts & Issues.’
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Issues
View Current Issues. The Issues window displays a Microsoft Explorer tree view of all the issues that
have been created in a particular case. Click on an issue to make it the Current Issue, as well as display
all facts in the fact table associated with the issue.

Create New Issue. Click the Create New Issue button in the lower left portion of Facts & Issues screen
(below Issues window).
The New Issue will appear in the Yellow Highlighted Portion of the Facts & Issues Screen. To input the
title
of
the
Issue
and
a
brief
explanation
(optional),
click
Edit.
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Click Update to save changes made to the newly created Issue.

Edit an Issue. Click Edit and then Update to save changes.

Lexbe eDiscovery Pla orm User Manual 2-2018

Page 84

Delete an Issue. Click on an issue to select it. Then click Delete at the top of the main table. After
clicking Delete, a new window will display the following message:

Select OK to delete the selected Issue.
Working with Facts and linking them to a selected Issue
Users can create and keep track of key facts in a case. Users can create a new fact by clicking on
'Create New Fact' to the left of the 'Current Issue Window.’ After selecting 'Create New Fact,’ the New
Fact dialogue window will open.
After clicking 'Create New Fact' users will see the New
Fact window. The New Fact window allows users to
enter a new fact, apply a date or date range, indicate if
the fact is contested or not, and associate underlying
documents with that particular fact.
● Title. Enter the substance of the fact in the Title
field. Facts will be easier to work with if the Title refers to
one fact, and not several facts or a compound fact.
● Task Date Start and End. The 'Start' field
indicates the start date for a fact and the 'End' field the
end date. If the fact occurs on a single date, enter that
date in the 'start' and 'end' columns. The eDiscovery
Platform allows US date formats to be used, e.g.,
‘2/12/2004 12:00 AM.’
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●

●

●
●
●
●
●

Doc/Page. Allows users to associate a fact to a specific page of one document. Users can only
assign one page at a time to a Fact. Please note that this functionality is only available for PDF
Documents and not Native Documents (Word, Excel, etc.).
Contested. The 'Contested' field allows users to indicate if a fact is contested or uncontested, and
if contested then, by whom. This allows users to identify which facts in the case may require
additional attention.
Material. The 'Material' field allows users to indicate if a fact is material, not material, or
undecided.
Assign Docs to Fact. The documents field allows users to associate one or more documents
with a fact. This allows users to track back a fact to its source or sources to prove up.
Assign Case Participants-Custodians to Fact. This field allows users to associate one or more
case participants with a fact.
Assign Facts to Issues. This allows users to associate facts to one or more Issues in the case.
Update or Cancel. When users have entered the fact as desired, click 'Update' to cause the
information to be saved in LEP. Otherwise click 'Cancel' and the fact will not be saved.

If users have a large number of facts and want to add a new fact, then to find the new fact entry area
users may need to scroll down the page.
users can keep track of key facts using 'Show Columns'. This action will display selected columns on the
main table, listing specific information related to each Fact.

Viewing Facts & Issues
In order to view a particular issue and its assigned facts, locate the issue link users wish to view in the
Issues Window. Every issue will display all its assigned facts and their timeline.

Filtering Facts and Issues
Users can filter on specific issues based on four criteria (Contested, Material Facts, Document and
Custodian). By filtering information in Facts & Issues, users can find values quickly.
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Organizing Research in LEP
The Case Research page allows users to identify legal research (e.g., applicable cases, statutes, articles)
and include summaries and full text (copy and paste). Research section is under the 'Analysis' tab on the
top navigation menu. This is helpful in preparing summary judgment motions, briefs and analyzing the
strength of various issues. Users can develop research and arguments in a collaborative environment
and can access research from any web-enabled computer. Users can upload copies of legal research
into LEP and link to it from the legal search module. Users research can be in any popular format (e.g.,
PDF, Word, Text, etc.).

KEY DOCUMENT ANNOTATIONS
Users can also access the Annotation section from the Document Viewer>Doc Tab. Users can annotate
or highlight PDF images or files opened in the Document Viewer Annotation. This feature allows users to
either annotate/highlight documents directly or manually upload documents previously annotated to
cases in LEP.
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This feature allows attorneys and paralegals conducting a review to highlight and create text notes in the
PDF version of any file, without affecting or automatically modifying the original. This can be used to
mark-up documents for witness examination, annotate deposition transcripts and other documents, and
for other purposes. The Annotation editor can help for cross-examination preparation, working with
experts, handling objections, assisting witnesses, and preparing transcripts.
To use this feature the following steps should be taken:
1) From the Browse or Search pages, click on the title of a particular document users want to annotate
2) Navigate from the top menu to the Annotation section (Document Viewer>Doc Tab)
3) Click 'Open Annotation Editor' hyperlink

Annotation Editor Page
This feature is used to annotate or highlight PDF images or files opened in the Document Viewer.
Documents that have previously been annotated outside of the Lexbe LEP (LEP) may be manually
uploaded to a case. This feature is not available for Read-Only or Limited users.
When users open the Annotation Editor page, users will see the message, 'Annotation images are being
created.' Refresh the current page and as result of that button click event, it will safely open only the file
to be annotated.

●
●
●

Select the area to annotate with the mouse. It should draw a gray box around the selection and
automatically open the 'Edit Annotation' Box
In the Enter Annotation Text field, enter any custom message that can be saved, deleted or even
canceled (e.g., ask witness about this)
Once the text or graphic has been saved, users can click on the 'Save Annotation' button and the
area selected will display the annotation in a blue light text area.

NOTE. To highlight a portion of an image in a PDF document, users repeat the same steps detailed
above, but without inserting text.
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From the Browse and Search pages users can display the built-in column 'IsAnnotated,’ and also apply a
'Show Annotated Only’ filter to view only the annotated version of the documents.

Download Annotated and Highlighted PDFs
Use the Download Briefcase feature to download and print annotated documents from the Search,
Browse, and Document Viewer pages.
The downloaded briefcase will include a sub-folder entitled Annotated in addition to Originals, PDF, and
Redacted (if applicable).

The non-annotated/highlighted PDF version will be included in productions under the PDF, TIFF, and
TEXT sub-folders.
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TRANSCRIPT HIGHLIGHTING
Users can also highlight transcripts by using Annotation section from the Document Viewer>Doc Tab, as
with Annotations above.

If needed, a parallel fact can be created (see right tab) to allow it to display in the ‘Facts and Issues’
timelines.
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REDUCING HOSTING COSTS IN LEP
Billing
In LEP monthly bill usage is calculated based on the highest GBs stored in an account for the current
month. The charges will also include the original file uploaded, the search index that LEP prepares to
make a case searchable, any OCRed versions of files (uploaded image PDFs that did not include text
prior to upload), and any case Productions or Briefcases of downloaded documents stored in the
account.

Tips for Reducing Costs
To reduce costs users should ensure that the case includes only needed ESI. Below users will find some
tips to help users manage accounts and cases.

TIP # 01: Deduplicate Documents
LEP identifies extra copies of Outlook email (PST and MSG), Outlook Express email (EML) and various
loose native files such as, Excel spreadsheets, Word files, etc. that users can delete from the case(s). It
helps to users to speed up indexing and reduces storage costs, users can use reduced redundancy
storage for non-critical data.

TIP # 02: Download and Delete unneeded Briefcases & Productions
To avoid charges in succeeding months, we recommend that users download to local desktop and delete
any Briefcases or Productions when no longer needed. Any administrator can delete unneeded
Briefcases from the Case>Download Briefcase page, and Productions from the Discovery>Production
Job page.
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These Downloads are in the form of ZIP archives of documents selected for download. They can be
downloaded directly with LEP, or a secure Shared Download link can be created to share with third
parties.

TIP # 03: Delete Container Files Successfully Expanded
Once users have uploaded and processed container files (ZIP, RAR, PSTs), users can also delete them
from the case(s) if they have successfully expanded. Please note that deleting container files after they
have been processed will have no effect on the original documents from which the upload .zip file was
created.
In our system container files are marked as 'Not Converted', whether they were expanded or not and we
do not identify container files that failed to expand. They need to be manually checked as follows:-From
the Browse page filter by 'Extension' (e.g. Filter Applied: Doc Extension=ZIP)
● Select the following fields: Extension, Original Extension, Source FilePath, Pages, Size and
IsEmailAttachment.
● If there is a nested folder structure in uploaded container files, then the paths will be automatically
mapped to the Source FilePath field in the application. In the example below, the Source FilePath
is giving us a list of all the documents compressed on each PST.
If users see all the paths automatically mapped to the Source FilePath and the container file is not an
email attachment, then we recommend that users delete it from the case to avoid extra costs.
When users don't see the paths from each document mapped to the Source FilePath, we recommend
that users review the original container file uploaded. Please note that files might eventually get corrupted
or damaged during file compression.
LEP also allows users to filter on container files that have been flagged as 'Not Converted', or 'Failed to
Convert'.
To delete container files go to the Case>Add Case Documents page, click on a batch upload title. This
action will take users to the Browse page and automatically filter on the documents from the specific
batch users selected.

TIP # 04: Archive Unneeded Cases
Account Admin users can delete cases that are no longer needed, but first we recommend that users
make a backup copy of the database before deleting records from the account.
If users wish us to download and send the data from an account, our Professional Services Staff can
download cases for users, copy to a flash drive and mail it, as part of our Professional Services (quote
provided upon request).
TIP # 05: Download and Delete Media Files
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Remove any media files uploaded to free up storage on case(s).

How to Allocate Billing within Cases
Users can easily calculate the case allocations by using an Excel spreadsheet exported from the
Account>Manage Cases page. This report helps users re-bill allocatable hosting costs back to clients.

The Account Billing Size table shows users one row per month with the highest monthly usage in the
current month and previous four months. However, users have the ability to track the current usage
status of an account by selecting all the cases and exporting the log to an Excel spreadsheet
The report will look like this when it opens in Excel.

Lexbe eDiscovery Pla orm User Manual 2-2018

Page 93

Lexbe eDiscovery Pla orm User Manual 2-2018

Page 94

DOCUMENT TROUBLESHOOTING
BASIC TROUBLESHOOTING INSTRUCTIONS
General
This troubleshooting guide discusses a number of things to check if users are having trouble uploading or
downloading documents to/from LEP. Problems can arise from a number of different causes and may be
associated with specific configuration issues in a browser or computer. The items below may solve the
problem. If not, the support team will be happy to assist to identify problems if users try these fixes first.
Upload & Download Issues
If users are experiencing problems downloading or uploading files from and to LEP, users should test
download speed and calculate how long it may take.
Need for Supported Browser and Current Browser Upgrade
We support the two most recent versions of Internet Explorer and Firefox for the PC and Safari and
Firefox for the Mac. It is important to upgrade to a recent version of a preferred browser regularly. The
best security is usually in the two most recent versions. Also, some of the most advanced functionality in
LEP will work only in the two most recent versions of our supported browsers. Lastly, we cannot
specifically address support issues that involve non-supported browsers or versions.

Benefit of Trying Alternative Browsers
If users are having a problem in a particular browser, try installing and using a different supported
browser for the operating system to see if the problem persists. For example, if users are using Internet
Explorer on the PC, try installing Firefox or Chrome or vice-versa. If users are using Safari on the Mac,
try installing Firefox or vice-versa. If the problem exists on only one of the browsers, it is likely due to
some specific configuration of that browser, and not something involving individual internet connection or
LEP servers. Similarly, if users have access to another computer, try logging in and trying the same
procedure there. If the issue does not repeat, then the problem can be localized to something computer
or browser specific.
Browsers Cache
If users are experiencing problems with a browser, the first thing users should do is clear the browser's
cache, cookies, and history. After clearing the browser's cache and cookies, exit it completely before
attempting to access LEP website again.
Windows
Internet Explorer 8 and 9
1. Click Tools, and select Delete Browsing History.
2. Deselect Preserve Favorites website data, and select Temporary Internet files, Cookies, and
History (leave the passwords and forms unchecked).
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3. Click Delete.
Internet Explorer 7
1. From the Tools menu in the upper right, select Delete Browsing History.
2. To delete the cache, click Delete files. Repeat the same steps for history, but users can preserve
the passwords and forms checked.
3. Click Close, and then click OK to exit.
Firefox 3.5 and later
1. From the Tools menu, select Clear Recent History.
2. From the Time range to clear drop-down menu, select the desired range; to clear the entire
3. cache, select Everything.
4. Click the down arrow next to "Details" to choose what history elements to clear (e.g., check
Cookies
5. to clear cookies). Click Clear Now.
Chrome
1. In the browser bar, enter: chrome://settings/clearBrowserData
2. Select the items users want to clear (e.g., clear browsing history, clear download history, empty
the cache, delete cookies and other site and plug-in data).
3. From the Obliterate the following items from: drop-down menu, users can choose the period of
time for which users want to clear cached information. To clear the entire cache, select the
beginning of time.
4. Click Clear browsing data.
Mac OS X

Safari
1. From the Safari menu, select Reset Safari.
2. From the menu, select the items users want to reset, and then click Reset. As of Safari 5.1,
remove all website data covers both cookies and cache.
Firefox 3.5 and later
1. From the Tools menu, select Clear Recent History.
2. From the Time range to clear drop-down menu, select the desired range; to clear the entire
3. cache, select Everything.
Don't Upload from CD/DVD Drives
If users need to upload files from a CD or DVD drive, users should first copy the files to a local hard drive
and upload from there. The delays of the read-write cycle from CD/DVD drives can cause an upload to
fail.

Try Rebooting the Computer
We know it is hard to believe, but it is not unusual for this to solve a problem. There are many ways for a
computer to get out of state, or run low on memory, and this can cause many strange behaviors. A
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reboot is a lot faster than an extended troubleshooting session!

Reinstall the Browser
If a supported browser doesn't work and neither do the other suggestions above, it may mean that there
is something wrong with the browser and it should be uninstalled and reinstalled.

Page Number Discrepancy
Some PDF Scanned Image types might be partially or totally corrupted, resulting in failure to display the
proper number of pages, redaction or contents under the Document Viewer tabs, represented by the
'Original', 'Html', 'Page', 'PDF', 'Text' and 'Hits' (available only when clicking from search results). This is
an issue with the original document, not LEP. PDFs can corrupt or partially corrupt for a number of
reasons prior to the document going into a case. If corrupt or partially corrupt, our indexing may be
partial or there may be no indexing. Partially corrupt PDFs sometimes will display in viewers and
sometimes not. Unfortunately, the fact that a PDF can open and print locally does not mean that it is not
partially corrupt. The procedure to fix PDFs like this is to have someone with experience in file
manipulation to get a better copy.
Options are:
● Get a better original (if one exists) and replace in LEP.
● Download the original currently in LEP, manipulate and re-sample (save) using PDF editing
software (e.g., Acrobat Pro) to re-sample and save. Possibly use multiple editors or methods, if
needed, as different editors can give different results. This is a manual iterative process and the
time to work with any document can vary a lot.
● Download the original and, if it opens okay in Acrobat or another PDF viewer, print and re-scan.
Then re-upload the new version. This approach obviously works better for smaller documents.
After this is done, re-upload to LEP and check that it is properly indexing and paginating.
To see if other documents have similar issues, we recommend the following for additional quality control,
if needed:
● Go to Browse and filter on the documents in question.
● Show the Ext (extension), Pages, Words and Size columns.
● Sort on Pages and look for documents with 1 and a small number of pages, but a large 'Words' or
'Size' values.
● This can also be done from Excel if users download the log.
Google Chrome Support
For stability and security reasons, Google Chrome recently changed the default settings for NPAPI
plugins (cross-platform plugin architecture) from enabled to disabled, and will also phase out support for
that type of plugin. We strongly suggest that users have at least two browsers installed especially if users
are having a problem with a particular browser.

Support for Mac
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Uploading Files
Once Settings have been set:
1. Click on the Add files button at the bottom and select the files to add from the user's local system.
The Mac does not allow the option of dragging batches of files from the computer directly into the
Upload Documents page.
2. Click on the Add files button to select and bring documents to the Upload dialog box.
3. From the upload window click the Cancel button to interrupt the file upload in progress. Progress
is shown for each individual batch and for the entire upload.
4. Do not close the upload window before the upload completes or the upload will be interrupted.
Configure Safari to Open PDFs inline
Safari can open PDFs in the browser window using a PDF Browser Plugin. After completing the
installation, upon opening Safari the user will be able to view this plugin under the Help->Installed Plugins
menu. This will cause the PDF to display inside the Safari window using its native PDF viewer. Close the
Preferences window and login to LEP, go to Browse to view all documents within the current case and
select any PDF file to be opened in a new tab.
Acrobat/Reader 8 also supports viewing PDF files inside Safari windows on Mac OS X and will only run
on Mac OS X 10.4.3 and later. It does not support any other browser (such as Firefox or Chrome).
Configure Firefox to Open PDFs inline
Firefox can also open PDFs in the browser window using the same PDF Browser Plugin. The initial steps
on how to configure Firefox are the same as from the Safari browser.
1. After completing the installation, on opening Firefox the user will enable or disable this plugin
under Firefox->Preferences->General->Add-ons->Manage Add-ons.
2. Close the Preferences window and login to LEP
3. Go to Browse to view all documents within the current case
4. Select PDF file to be opened in a new tab. This will cause the PDF to display inside the Firefox
window using its native PDF viewer.
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This enables PDF support and editing features in Safari and Firefox web browsers. If the user cannot
see the Find function, use keyboard shortcut "Command F," type the word to find, and hit enter. Problems
may persist because Acrobat or Adobe Reader 8 automatically install themselves as the default PDF
viewer for Safari and Firefox on the Mac OS X. To disable, start Acrobat or Adobe Reader, go to
Preferences->Internet and uncheck the Display PDF in Browser option. This will cause the PDF to display
inside the Safari/Firefox window using its native PDF viewer.

Configure Google Chrome to Open PDFs inline
To preview a document, there is a PDF plugin on the Mac that allows for the inline viewing of PDFs in
Google Chrome. Make sure users have the latest version of Chrome. To view, type "about:plugins" in the
website address box and select "chrome://plugins." There should be a disabled plugin called Chrome
PDF Viewer.
If the user does not see this plugin and needs to install it, follow these steps:
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1. Open Google Chrome and go to Chrome->Preferences->Extensions
2. Click on Get more Extensions and install PDF Browser Plugin 2.4.2-Version: 2.4.2 or the latest
version available
3. Close the Preferences window and login to LEP, go to Browse to view all documents within the
current case and select PDF file
How To Preview Native Documents in Firefox/Safari Without Leaving the Browser
To view native files on Firefox and Safari, install any open-source application suite compatible with
Microsoft Office. The application called iWork is recommended by Apple for the Mac OS X.
Configure Firefox/Safari to Open Native files Inline (Preview-iWork)
See Viewing Native Files for more information in the Help Pages for more information.
Configure Google Chrome to Open Native files inline
Chrome can be configured to automatically open native files.
information in the Help Pages for more information.

See Viewing Native Files for more

Have Multiple Browsers on Mac
Best practice is to have more than one browser configured for use with LEP (e.g., Safari and Firefox). If
problems occur, switching browsers can sometimes resolve an issue. Multiple browsers also aid support
staff in troubleshooting configuration problems.
How to Create a ZIP file on Mac OS X
1. Select the item or items users want to compress and choose File->Compress
2. Control-click an item and choose Compress from the shortcut menu.
3. In a Finder window, select one or more items and choose Compress from the Action menu (looks
like a gear). If compressing a single item, the compressed file has the name of the original item
with the .zip extension. If compressing multiple items at once, the compressed file is called
Archive.zip
4. Double-click the .zip file to uncompress (expand) an item.
How to Create a RAR file on Mac OS X
One RAR utility available for Mac and similar to WinRAR is SimplyRAr. users can use this to create zip
files of files, folders, or both. After installation, follow these steps:
Select the item or items to compress. Select multiple files and folders by holding down the Shift key (for
multiple items) or the Command key (for several individual items), then click. After file and folders are
selected, right click and select Compress 'XX'. A window will appear indicating that the Mac is
compressing the files or folders. Depending on the size of the files or the folders, this could take a couple
minutes. Once finished compressing the files or folders, there will be a zip file. This will contain all of the
files and folders selected to be compressed.
Control-click an item and choose Compress from the shortcut menu.
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Select Compress Items.
Find the newly created .zip archive in the same directory. If compressing a single item, the compressed
file has the name of the original item with the .zip extension. If compressing multiple items, the
compressed file is called Archive.zip.

How to Unzip/Extract and View File Containers (ZIP or RAR files)
The default Mac unzip utility uses the Zip 32 bit algorithm for maximum compatibility while Lexbe uses
the 64 bit Zip algorithm to allow archives larger than 2 GB in size. The default Mac unzip utility will
therefore not work with Lexbe zip files. Instead, users need to use a 64 bit compatible unzipper such as
The Unarchiver.
Sometimes unzipping files on the Mac will result in a new .zip.cpqz file or unzip to show only a single file.
Lexbe uses the newer Zip64 archive format. The default Mac unzipper is not Zip64 compatible. To avoid
this issue and actually unzip the archive, do the following:
1.
2.
3.
4.
5.

From the Safari menu select Preferences
Uncheck "Open safe files after downloading"
Download the zip file from LEP
Locate the downloaded file in Finder and Control-click the file
Select Open With and select The Unarchiver.app. Do not use the Archive Utility.app (default). If
The Unarchiver.app is not installed, select App Store and search for and install The
Unarchiver.app. This will unzip the archive and show all the files.

JavaScript
Check if JavaScript is enabled in order to allow websites to display properly. If using Safari or Firefox,
follow the steps below:
Safari:
>Click the Safari menu at the top and select Preferences.
>Click Security and check the box next to Enable JavaScript.
>Close the Preferences window to save the settings.
Firefox:
>Click the Firefox menu at the top and select Preferences.
>Click the Content tab and check the box next to Enable JavaScript.

>Close the Preferences window to save the settings.
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APPENDIX A:
Glossary

Annotation

The Annotation Editor gives users the ability to review
and highlight transcript text and associate deposition
statements made by case participants with important
documents and timeline events.

Bates Stamping

This procedure assigns a Bates stamp to the lower right
of a document. Within LEP, this is available for PDF and
TIFF documents. Native files cannot be Bates stamped at
the page level, but only Bates named.

Bates Numbering

This assigns numbers to files and documents in a case
database. For natives, it is one number per file (e.g.,
SMITH 0000100.docx), which is the beginning page of the
document, if printed. For PDFs and TIFFs, the number is
one per page (e.g., SMITH 0000100-120.pdf).

Bates Naming

As part of a production, files are saved with their Bates
names (title). This is true for native files, TIFFs and PDFs.

Built-in Fields

All the fields listed under the Show Columns>Built-in Doc
Fields section that can be accessed from the Browse,
Search and Document Viewer pages.

Custodian

Custodians are the litigants, deponents, witnesses, and
other individuals and organizations in the case that
provide factual information. These persons are often
custodians of electronic stored information (ESI) in a
case.

Claw-Back Agreement

A claw-back (or clawback) agreement is a formal
understanding between the parties involved in litigation,
sometimes memorialized in a court order, that any
production of privileged and protected information is
presumed to be inadvertent and does not automatically
waive attorney-client privilege.
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Container File

It refers to certain compound file types that can be
separated into constituent parts or reassembled, without
losing data inherently as part of the conversion process.
(e.g. ZIP, RAR, PST, MSG files, etc.)

Culling

This is the process of searching and processing a pool of
documents for specific information useful to a case.
Documents containing useful information are extracted
from the entire case database.

Custom Doc Fields

All the fields listed under the Show Columns>Custom Doc
Fields section that can be accessed from the Browse,
Search and Document Viewer pages.They are unique
sections/columns that the Account Admin User(s) creates
for the case. It consists of a Coding Section and a Coding
Field. The Coding Section will provide the category name.
The Coding Field will be the specific tags with which
users wish to populate the Coding Section.

Deduplication

Extra copies of Outlook email (PST and MSG), Outlook
Express email (EML) and various loose native files such
as Excel spreadsheets, Word files, etc. are often found in
duplicate form in a case. Exact duplicate identification is
based on an MD5 Hash of loose native files, and an MD5
Hash of email metadata for Outlook MSG files.

deNISTing

A part of eDiscovery Processing that takes place on the
import (or ingestion) of native files into LEP, or upon
conversion processing jobs (e.g., eDiscovery Culling+,
Native Extraction+, Native TIFF+, Native PDF+) where
certain files that are unlikely to result in evidence are
removed from the data set and ignored for further
processing.

Email Attachments

Files sent along with an email message, and embedded
as part of email MSG files.

Email Body

The main part of an email message, which is embedded
as part of an email MSG file.

Email Metadata

Data fields that can be extracted from email container
files, such as MSG, including most importantly Email
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sender, recipients, cc recipients, bcc recipients, date and
time sent, date and time received, and subject line.
Email Threading

Email messages that have similar text representing a
conversation thread, including a running list of all the
succeeding replies starting with the original email. The
replies are visually near the original message, usually in
chronological order from the first reply to the most recent
(e.g. the original email, then the response to the original,
then the response to the response). Threading can be
accomplished with several technologies, including
grouping of near duplicates and use of a MessageID field
in email metadata.

ESI

Acronym for 'Electronically Stored Information', which
refers
to
information
created,
manipulated,
communicated, stored, and best utilized in digital form,
requiring the use of computer hardware and software.

ESI -Near Native

Near native is subcategory of ESI that refers to electronic
documents rendered into a native format for review, that
differ from the original format. An example is relational
databases (e.g., Microsoft Access, SQL Server or Oracle)
that render data into a series of Excel spreadsheets for
review, by running queries against the database.

ESI - Near Paper

A subcategory of ESI that refers to electronic documents
in the Group IV TIFF or PDF formats, and often have
been converted from natives or near native ESI.

ESI - True Native

A subcategory of ESI that refers to electronic documents
in the format created by the authoring application, such as
DOC or DOCX for Microsoft Word and XLS and XLSX for
Microsoft Excel. Native documents will include metadata.

Exact Duplicates

Two or more documents are exact duplicates when the
textual content of the two documents is the same. A
Microsoft Word file and the PDF version of that file are
duplicates. Exact duplicates are based on MD5 hash
values.

HTML files

These are the text versions extracted from the original
documents without using applications outside of LEP.
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Identical

Two or more documents that will have the exact same
extension, subject, number of words and content.

LEP

Lexbe’s cloud-based eDiscovery application and litigation
document processing, production, review & case
management software.

Linear Review

Manually reviewing & coding all documents in a case or
review set, one at a time, in LEP. Mass coding may be
done using the multi doc edit function from the Browse or
Search page or by using our Power Upload user feature
to code using Excel.

Load Files

Load files are plain text files using characters called
delimiters (comma, tab or special character delimiters) to
separate the various metadata items in the load file. Load
files include reference and association of data items such
as Bates number or control number, beginning and
ending Bates number of a document, beginning and
ending Bates number of email attachments, date (various
date fields are commonly collected including date/time
sent and received for email and date last modified for
other native files), sender or author, receiver, and
custodian. Examples of loadfile formats supported in LEP
are Excel XLSX (LEP loadfile), DAT/OPT (CaseLogistix,
Clearwell, Concordance, iConnect, iPro Allegro,
Relativity) and DII (Summation).

MD-5 Hash value

The MD-5 Hash is a commonly used cryptographic
function that produces a 128-bit (16-byte) hash value,
expressed as a hexadecimal number, 32 digits long.
MD-5 is used to check data integrity.

Metadata

Data fields that provide basic background information on
the file. It will contain identifiers like sender, date it was
sent, the type of file, who received it, etc. It will also
contain a control i.d. number or other methods of
identifying the file.

MSGs

An MSG file is a file format specifically designed for
storing individual emails. An MSG file can contain plain
ASCII text for the headers and the main message body as
well as hyperlinks and attachments.
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Native Files

Native file format refers to the default file format that an
application uses to create or save files.

Near Duplicates

Near Duplication feature helps users to identify files that
contain contextually similar sentences or subject, but are
not exact matches. Our Near Duplication technology
identifies and groups documents that are at least 50%
similar in text content.

Normalized PDF

LEP automatically creates a 'normalized PDF' version of
all supported file types uploaded to the application. This is
done to allow for better document viewing, to increase
searchability, to allow Bates stamping at the page level, to
allow redaction, to allow document splitting, and for other
functions.

OCR

OCRing is the process of applying optical character
recognition to improve searchability. This feature allows a
user to search a document like a .pdf for the words in the
file.

Power Upload User

Account Admin users in LEP with full control over an
account , but who also have the ability to modify
document coded data and tag multiple files (modify
multiple columns simultaneously), or import load files by
generating custom Excel spreadsheets that can be
uploaded into a case, or to upload multiple files under one
record in LEP (self-loading Summation and Concordance
load files) are referred to as Power Upload users. To
become an Account Admin User with Power Upload
rights, please submit a ticket at our support center.

Placeholder File

When we do not convert files, we generate a PDF or TIFF
placeholder page, and also flag the file as either 'Not
Converted' or 'Failed to Convert'. A placeholder page
identifies that a file was not converted, and also can't be
Bates-stamped.

PDF

PDF is an acronym for 'Portable Document Format’, and
refers to a file format designed to represent documents in
a manner independent of application software, hardware,
and operating systems.

PDFing

The process of rendering a native file or TIFF image as a
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text-based PDF (in the case of text-based native file), an
image only PDF (in the case of a TIFF or an image-based
native file) or a text-under-image PDF (if OCR is applied
to an image-based PDF following conversion from a TIFF
or image-based native file).
PDF - Text-based format

A text-based PDF has usually been created from a native
file (e.g., Word, Excel, etc.). It has not been scanned and
does not include bitmapped or raster images as part of
the file.

PDF format

A PDF that includes images (usually from a scan) and
also a text layer associated with the page (usually from
OCR).

Text-under-image

PDF- Image only format

An image only PDF consists of one or more raster or
bitmapped images, usually from a scan. An image only
PDF includes no computer-readable text associated with
the page images, and therefore is not searchable.

PDF - Portfolio format

A portfolio format PDF is a specific compound PDF file
format created using later versions of Adobe Acrobat Pro.
As a compound file, a Portfolio PDF can contain
embedded PDF and other files.

Privilege Log

LEP automatically generates a privilege log with all the
productions users create and a privilege log of all
privileged documents for opposing counsel’s review. The
privilege log can be exported to an Excel spreadsheet for
finalization and delivery.

Privilege Log (Custom)

A custom privilege log could be expanded with either LEP
Built-In Fields, or with custom fields users might create.

Production

It is the collection and inspection process of relevant
documents in the possession or control of an adversary
pursuant to discovery. The applicant must have a
reasonable belief that such evidence is necessary to the
lawsuit if discovery is to be granted.

Production Load File

As part of our eDiscovery Processing Services, we also
support production load files for use in all major review
platforms (Concordance, Summation, Relativity, Ringtail,
Opticon, etc.).
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Quality Control

This is the process by which self-service Platform users
or eDiscovery Services review the quality of all steps
involved in document upload, review, processing and
production.

PSTs

A PST is an open proprietary file format used to store
copies of messages, calendar events, and other items
within Microsoft software such as Microsoft Exchange
Client, Windows Messaging, and Microsoft Outlook.

RAR Files

RAR is the native format of WinRAR archiver. Like other
archives, RAR files are data containers and store one or
several files in the compressed form.

Redaction

Redaction in the legal review or litigation document
production area is the removal of privileged, work product
or confidential data subject to privacy restrictions from
documents that will be produced or released.

Redaction Log

LEP enables users to redact documents in the document
viewer or upload documents redacted locally, and have
either type, when created or uploaded as described in
redaction help, display in the Document Viewer under the
'Redacted' tab.

SFTP

Secure File Transfer Protocol (SFTP) is a secure network
protocol used to transfer files from one host to another
host over a TCP-based network, such as the Internet over
an encrypted ssh transport.

Tagging

This is the process in LEP where users will use the
Built-in and Custom Doc fields to identify documents and
associate with multiple specific issues users have
established for a case such as Responsiveness,
Confidentiality, Privilege, and other issues as needed.

TIFFing

The process of rendering a native file or PDF as a TIFF
image.

TIFF Images - Group IV

Tagged Image File Format (TIFF) is a file format for
storing images, and is a popular option for storing digital
versions of paper documents, and page-based file images
converted from native files.
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ZIP Files

A ZIP file is a computer file whose contents of one or
more files are compressed for storage or transmission,
often carrying the extension.
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APPENDIX B:
Supported File Types

This document will give the user an overview of the types of files supported by the most current
version of LEP. It will cover what files LEP can support, as well as files types converted standard as part
of eDiscovery Services, the applications typically associated with the file, and the extensions of these
files. It will also provide insight as to what file types are not supported and will be receiving a placeholder.
This will review the most widely used text/word processing files, container files (for example, .zip and .rar
files), media files, email files, and database files that can be converted.
Prior to converting files, we apply container file expansion, DeNIST, and extension repair
procedures. Files that we do not convert as part of our automated processing services are marked with a
placeholder file.

Standard File Types for Conversion
We identify and attempt to convert (to TIFF or PDF, depending on the service), the following file
types:
Ext

Application / Description

Type

bmp

Image BMP

Image

class

Java programming file

Text/Word Processing

config

Application configuration File

Text/Word Processing

css

Cascading style sheet (web page support)

Text/Word Processing

csv

CSV (Comma-separated values) (*.csv)

Text/Word Processing

doc

Microsoft Word 2003 for Windows (*.doc)

Text/Word Processing

docx

Microsoft Word 2007 and 2010 for Windows (*.docx)

Text/Word Processing

dwg

Autocad native format

Design Data
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dxf

Autocad Drawing Exchange format

Design Data

eml

Microsoft Outlook Express email

Email

emlx

Apple file

Email

gif

Image GIF

Image

htm

HTML web page

Web Page

html

HTML web page

Web Page

ics

iCalendar file

Text/Word Processing

inf

Setup Information File

Text/Word Processing

ini

Text configuration file

Text/Word Processing

jpeg

JPEG

Image

jpg

JPG

Image

js

Javascript programming file

Text/Word Processing

json

Javascript object notation file

Text/Word Processing

key

iWork Keynote for Apple Macintosh

Presentation

lnk

Windows File Shortcut

Text/Word Processing

log

Application log file

Text/Word Processing

manifest

Java programming file

Text/Word Processing

mht

HTML web page

Web Page

mht

MHT archives (HTML archives saved by Internet Web page
Explorer) (*.mht)

msg

Microsoft Outlook email

Email

numbers

iWork Numbers for Apple Macintosh

Spreadsheet

pages

iWork Pages for Apple Macintosh

Text/Word Processing
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pdf

Adobe Acrobat (converted from text)

Text/Word Processing

pdf

Adobe Acrobat (image only)

Image

pdf

Adobe Acrobat (text under image)

Image

pdf

Adobe Acrobat PDF Portfolio*

Image

php

PHP programming file

Text/Word Processing

png

PNG image

Image

pps

Microsoft PowerPoint 2003 for Windows

Presentation

ppsx

Microsoft PowerPoint 2007 and 2010 for Windows

Presentation

ppt

Microsoft PowerPoint 2003 for Windows

Presentation

pptx

Microsoft PowerPoint 2007 and 2010 for Windows

Presentation

pst

Microsoft Outlook data files

Container

py

Python Programming Script

Text/Word Processing

rar

RAR

Container

rtf

Microsoft Rich Text Format (*.rtf)

Text/Word Processing

tif

TIF

Image

tiff

TIFF

Image

txt

ASCII Text

Text/Word Processing

url

Uniform Resource Locator file

Text/Word Processing

vcf

Vcard contact information file

Text/Word Processing

xls

Microsoft Excel 2003 for Windows (*.xls)

Spreadsheet

xlsm

Microsoft Excel 2007 and 2010 for Windows (*.xlsx)

Spreadsheet

xlsx

Microsoft Excel 2007 and 2010 for Windows (*.xlsx)

Spreadsheet

xml

XML text

Text/Word Processing
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zip

Archive container ZIP (*.zip)

Container

Failure to Convert Standard File Types
If we attempt to convert one of the standard file types above and cannot, our procedure is to
create a placeholder file and indicate in the database record that the file 'Failed to Convert'. The standard
file types may fail to convert for a variety of reasons, including file corruption, file type mis-identification,
print or data extraction issues, and password protection.
Some non-converted standard file types can be converted with manual technical support services
(hourly or per GB charges depending on file type and issues involved).
*Currently our system will index and make PDF Portfolio files searchable, but not for
automatic processing to allow separation and Bates stamping.

Other Files Not Converted
We do not attempt to convert files other than the standard file types above. When we encounter a
file type not considered 'standard', our procedure is create a placeholder file and indicate in the database
record that the file was 'Not Converted'.
Some non-converted non-standard file types can be converted with manual technical support
services (hourly or per GB depending on file type and issues involved).
Files not Converted include a number of file types, including Media Files, some Container Files,
some Email Files, Database Files, and other file types as described below.
Failure to convert a file does not mean it does not contain probative evidence, only that we did not
convert it with our automated procedures. These files should be reviewed and further steps to make
reviewable should be considered, when appropriate.

Media Files
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Media files (video and audio) cannot be converted to TIFF or PDF. The following is a listing of
common media file types. These can be uploaded to LEP, their records coded, and sometimes viewed or
played depending on file type, connection speed and local browser and computer settings and installed
applications. The following is a listing of common media types:
Ext

Application / Description

Type

avi

Windows video

Video

asf

ASF

Video

m4a

QuickTime

Video

m4p

Apple

Video

m4v

QuickTime

Video

mov

QuickTime

Audio

mp3

MP3

Audio

swf

Flash

Video

wav

Wav file

Audio

wma

WMA

Audio or Video

wmf

Windows

Metafile Format

wmv

Windows Video

Video

vgs

Virtual Game Station Memory Card Save

Video

Unusual Container Files
As part of our automated processing, we extract ZIP and RAR files. We do not automatically
extract more unusual container files. Some types we do not process include 7z, G7, Iza, Jar, Sit. We can
extract many container files that we do not automatically extract as part of a separate technical
processing (hourly cost). The following are common file types users may wish for us to convert in any
particular file set if present.
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Email Files
Our automated conversion processes automatically processes and converts common email files.
Ext

Application

.bbm*

BlackBerry Messenger Text Messages

.bbmr*

BlackBerry Messenger Receipt

eml

Microsoft Outlook Express & Windows Mail

emlx

Apple Email

msg

Microsoft Outlook (Message)

pst

Microsoft Outlook (Container)

py

Python Programming Script
In native deliveries of electronic discovery, email file types are often saved as or converted to

Microsoft PSTs as part of collection. Please note that if users are self-uploading PST files, our system
first will extract the emails and then attempt to convert them to PDFs as part of our automated file
processing. However, we do not automatically repair corrupted PSTs because it involves manual
intervention that might stall processing queue.
There are a number of factors that will corrupt or damage an Outlook PST files such as, sudden
shutdown of the program without data being saved due to system crash, exceeding the maximum file size
(2 GBs), virus infection, Outlook program being defective or even upgrading to a newer Windows version
can also result in corruption. For those reasons, PSTs often need repair prior to upload to avoid data
corruption.
*Blackberry messages are partially supported that can be processed using XML query and
converted to PDF files. It will require some manual processing prior to upload. Please see our technical
note ‘Working with Blackberry Files’, available on our website.
Other email files or stores must be manually or batch converted prior to automated processing
(separate job and cost). The following are email types we do not automatically process but can process
manually (separate technical support job).
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Ext

Application

dbx

Microsoft Outlook Express

mbs

Opera Email for Windows

mbx

Eudora MBX message files

mbx

MBOX email archives (including Thunderbird)

ost

Outlook offline folder file

nfs

Lotus Notes email

Database Files
Our automated conversion processes do not convert database files. If data is to be extracted,
then someone should open the databases individually and query them for applicable reports, and then
save as text, Excel spreadsheets, or PDFs for further processing. We do this as a manual technical
support service (hourly). The following are database types we do not automatically process but may
process manually (separate technical support job), depending on type and version.

Ext

Application

dbf

Oracle or other database

frm

MySQL

myd

MySQL

myi

MySQL

mdb

Microsoft Access Database 2003

mdbx

Microsoft Access Database 2007 and 2010

iif

Intuit interchange file (Quickbooks)
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ldf

SQL Server

qba

Quickbooks

qbb

Quickbooks

qbm

Quickbooks

qbw

Quickbooks

qbx

Quickbooks

qby

Quickbooks

MAC Files
Our automated conversion procedures support most Apple Macintosh productivity files (.pages,
.numbers and .key) Other Macintosh file types may not automatically convert depending on version and
other factors.

Other Files Not Automatically Converted
We do not automatically convert a number of file types that may include relevant data. For many
we can convert to PDF or TIFF with non-automatic procedures with eDiscovery Services, but this
requires a separate job and instructions. The following are common file types users may wish for us to
convert in any particular file set if present.
Ext

Application

Type

123

Lotus 1-2-3 (*.123, *.wk?)

Spreadsheet

art

Bitmap image file compressed by (AOL)

Graphic/Image

doc

Microsoft Word for the Mac (any version)

Text/Word Processing

docs

Microsoft Word for the Mac (any version)

Text/Word Processing

epsf

EPSF

Image

hjt

Treepad HJT files

Other
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mpp

Microsoft Project 2003

Other

mppx

Microsoft Project 2007 - 2010

Other

obd

Office binder document

Container

qpw

Quattro Pro

Spreadsheet

sam

Ami Pro (*.sam)

Text/Word Processing

tmp

Application Temporary File

Other

vdx

Visio XML files (*.vdx)

Image

vcf

MS Outlook, other programs (contact info)

Text

xlk

Backup file created by MS Excel

Other

wb1

Quattro Pro

Spreadsheet

wb2

Quattro Pro

Spreadsheet

wb3

Quattro Pro

Spreadsheet

wks

Microsoft Works

Text/Word Processing

wpg

WPG (WPG version 1.0 only)

Image

APPENDIX C:
Built-In and Metadata Fields
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Field Name

Description

LF*

Bates Prefix

Leading letters that easily identify the documents being
stamped and a number sequence.

X

Bates Number

Bates numbering is a method of numbering pages of a
document using a Bates stamp device which
automatically increases the page number with each use
of the device. It provides identification, protection, and
auto-increment numbering of the images.

X

Hash MD5

The MD-5 Hash is a commonly used cryptographic
function that produces a 128-bit (16-byte) hash value,
expressed as a hexadecimal number, 32 digits long.
MD-5 is used to check data integrity. The value will
change if there is any change in the contents of a file, but
the hash value is independent of the file name, as it is
stored on the operating system, not in the file. LEP
deduplicates loose native files using an MD5 hash of
each file.

Doc ID

This is an internal string of numbers automatically
generated

to

keep

uploaded/processed.

It

track
identifies

of
which

each

file

documents

printed before Bates numbers have been used (e.g.,
during review process before a production), and also
allows multiple productions (different Bates) where the
produced document is the same (same Doc ID as a
control number)
Control Number

Sequential numbers (inline) that can be automatically
assigned during a batch upload in LEP. It will assign one
sequential control number for the entire document, as
opposed to the Bates Stamping that assigns a sequence
of numbers and letter at a page level.

Original Title

Original title of document uploaded in LEP.

Description

Brief details about the file. (e.g. Picture)

Extension

Shows the current file format. (.PDF, .DOC, .PPT)
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Original Extension

Shows the original file format.

Doc Category

This is a broader categorization of documents like ‘HTML’
or ‘Spreadsheet.’

It's determined at time of processing

and refers to the original file before conversion.
Source FilePath

This refers to the Folder Path within Microsoft Outlook

X

and keeping folders and subfolders information. It is
named after the original sender of all email data.
Pages

This refers to the number of pages shown in the

X

document, so users can either open it from the Doc or
Page View from the Document Viewer.
Words

This shows the number of words in the Search Index for
that particular document. Please note that the 'Word'
columns will not contain any data (all 0) until the case has
been re-indexed.

Size

This shows the size of the document (e.g. 2.73 GB), and
this will help users either open the file from the Page or
Document View tab depending on internet speed, time,
and coding.

Doc Date

This is a control field. During the review, users can use
this field to consolidate the dates for searching, filtering,
and eventually producing files. During the self upload or
an eDiscovery job, our software will extract from the
emails the ‘Date Sent’ value and automatically populate
the Doc Date or Date field by default.

Master Date

>Emails: It is the 'Date Sent'. This will date will also be
propagated to all the attachments of their parent email.
For example, if users have an email that was sent at
1/1/2001 at 1PM, then the email and any of its
attachments will have the same Master Date (1/1/2001 at
1PM).
>Native files: It is the 'Date Last Modified' or the 'Date
Created' (if date last modified is not available)
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Date Sent

LEP will extract and use the ‘Date Sent’ from the emails,

X

unless the original was blank, in which case ‘Date
Received’ will be listed.This field will be left blank for
native files.
Date Received

LEP will extract and use the ‘Date Received’ from the

X

emails to be displayed as a column, unless the original
was blank.
Date Created

This will show the date that is stored in the properties of
the file, when it was first created (from an eDiscovery
processing job uploaded to LEP).

X

This shows the last time the file was modified or edited
(from an eDiscovery processing job uploaded to LEP).

X

Folder

If documents are assigned to a specific folder in LEP,
this column will display the name of it.

X

Custodian

This will display the Case Participants (aka Custodian)
linked to the file.

X

Date
Modified

Last

Key Document

Notes

This will display the icon
, if file is marked as a
key document.
It indicates the most relevant documents to be
produced (editable).
This will display the icon
, if the file has notes
users can drag the mouse directly to the icon to view
the contents of each note (editable).

Bates

This shows the labeling used in the files (editable).

Responsive

This will display the icon
responsive (editable).

Attorney-Client
Privilege

This shows which documents must be kept only

Attorney
Product

This shows which documents are under the Attorney
Work Product in anticipation of litigation from discovery

Work

between the attorney-client (

by opposing counsel (
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Confidential

This will display the icon
, if file has been marked as
confidential by the user(s) and print the text
'Confidential' on the lower right of a Bates stamped
page once the user’s production or download is
complete (editable).

Custom
Designation

This will also display the icon
, if file has been
marked with the Custom Designation tag by the
user(s). The Custom Designation tag is equivalent to
the 'Attorney Eyes Only', 'Confidential', 'Subject to
Protective Order' or other special designation for
confidential documents and it will print a message on
the lower right of a Bates stamped page once a user’s
production or download is complete.

Doc Source

Doc Sources are used to identify an entire set of
documents at the same time and also allow filtering.

From

This shows the sender’s name by pulling it from the
original email.

X

To

This indicates the email was sent to another email
address.

X

Cc

This also indicates if a copy of the email was sent to
another recipient via carbon copy.

X

Bcc

Indicates if a copy of the email was sent to Blind carbon
copy.

X

Subject

This refers to the subject matter line of the email.

X

Doc Type

This refers to the type of document. (e.g. Email body,
Email Attachment, Native etc).

X

Near Dup Group

It contains similar versions of documents that differ by, for
example, a few sentences, words or paragraphs. It
allows users to find similar key documents, accelerate
review by mass tagging similar documents, checking
consistency on responsiveness and privilege groupings
between similar documents, email threading, etc.

Visual Group

Identifies documents visually classified to simplify and
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speed legal review.
Date Uploaded

This allows users to view the date the file was uploaded
to the case.

IsEmailAttachment

The emails and their attachments are displayed together
in LEP.

Placeholder

Display placeholder files and files not converted in
eDiscovery processing.

IsDuplicate

Represents exact copies using MD5 Hash identification of
email and loose native file.

IsTranslated

This will display documents that have translated versions
in the document record.

IsRedacted

This will display documents that have redacted versions
in the document record.

IsAnnotated

This will display documents that have annotated versions
in the document record..

X

Included in Loadfile on Production
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